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This site requires an HP Passport account. If you do not have one, click the Create an account button on the
HP Passport Sign in page.

Support
Visit the HPE Software Support website at: https://softwaresupport.hp.com

This website provides contact information and details about the products, services, and support that HPE
Software offers.

HPE Software Support provides customer self-solve capabilities. It provides a fast and efficient way to
access interactive technical support tools needed to manage your business. As a valued support customer,
you can benefit by using the support website to:

l Search for knowledge documents of interest
l Submit and track support cases and enhancement requests
l Download software patches
l Manage support contracts
l Look up HPE support contacts
l Review information about available services
l Enter into discussions with other software customers
l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a
support contract. To register for an HP Passport ID, go to https://softwaresupport.hp.com and click Register.

To find more information about access levels, go to:
https://softwaresupport.hp.com/web/softwaresupport/access-levels

HPE Software Solutions & Integrations and Best Practices
Visit HPE Software Solutions Now at https://softwaresupport.hp.com/group/softwaresupport/search-result/-
/facetsearch/document/KM01702710 to explore how the products in the HPE Software catalog work
together, exchange information, and solve business needs.

Visit the Cross Portfolio Best Practices Library at https://hpln.hpe.com/group/best-practices-hpsw to access a
wide variety of best practice documents and materials.

About this PDF Version of Online Help
This document is a PDF version of the online help. This PDF file is provided so you can easily print multiple
topics from the help information or read the online help in PDF format. Because this content was originally
created to be viewed as online help in a web browser, some topics may not be formatted properly. Some
interactive topics may not be present in this PDF version. Those topics can be successfully printed from
within the online help.
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Color Your Data
This section introduces BVD:

• Introducing BVD 7
• Logging Into BVD 8
• My Account 9
• Get Started 10

Introducing BVD
Data does not have to be big to be confusing. It often comes in different formats or languages, and is spread
over different locations and devices. This makes it all the harder to bring data together into one view,
displaying only the latest andmost important information.

HPE OMi Business Value Dashboard (BVD) brings your data to life. Use BVD to create custom, flexible
dashboards that visualize information in an appealing way and that can be accessed anywhere, anytime,
from any device. Incorporate your own graphics, add color to identify status, and receive real-time updates—
so you always understand the value driven by your IT environment.

BVD, color your data.
Anytime, Anywhere. BVD dashboards are real-time dashboards. You choose how often you send
data to BVD; BVD displays the data with no delay. You decide where you want to view your
dashboards: PC, tablet, or phone. BVD supports themajor browsers. Choose your favorite!

Simple, Colorful, Flexible. Design your dashboards usingMicrosoft Visio. BVD provides a Visio
stencil with shapes that then later become the widgets in your dashboards. The shapes include
widgets for drawing charts, coloring text or values, displaying information feeds, web pages (for
example, video streams), andmany more. You can of course also style your dashboards

according to your company's style guidelines. BVD provides sample dashboards to help you get started.

Connect. Once uploaded to BVD, you connect your widgets to the data. The BVD Manage
Dashboards pagemakes this task simple and efficient. You can set additional widget options such
as rules that determine the visibility and status colors of the widgets; or you can link widgets to
other dashboards to enable drill down.

Integrate. BVD can process any kind of data as long as it is sent in JavaScript Object Notation
(JSON), a language-independent, open data format. The out-of-the-box integration with OMi
facilitates the integration of event and KPI status as well as metrics data. BSM Connector
provides policies that automatically forward data collected from various sources to BVD.

Alternatively, create your own integrations for any data source by writing an adapter for BVD. The adapter
must convert the source data to JSON and send the JSON-enabled data to the BVD data receiver.
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Logging Into BVD
You can access BVD using a supported web browser from any computer with a network connection to the
BVD server. The level of access granted to a user depends on the user's permissions.

For a list of supported browsers, see the support matrix:

Support Matrices for Operations Center products

Download and extract the support matrix files, open the document SUMA.htm and select Operations
Manager i Business Value Dashboard from the product list.

Tasks
This section includes:

l "How to Log Into BVD" below
l "How to LogOut of BVD" below

How to Log Into BVD
1. In a browser, enter the following URL:

http(s)://<BVD_server>:<port>/login/

where

<BVD_server> represents the Fully Qualified Domain Name (FQDN) of the BVD server; <port> is the
port assigned to BVD during the configuration. Example: http://bvd.example.com:80/login

2. Enter your login name and password. Initial access can be gained using the administrator user name and
password as specified during the BVD configuration.

Caution:We recommend that the system superuser change this password upon first login to
prevent unauthorized entry. For details on changing the user password, see "My Account" on the
next page. The login name cannot be changed.

Note: Youwill be temporarily locked out from signing into BVD after five failed attempts to sign into
BVD. When your account is locked you will not be able to sign in, even with the correct password.
The lock lasts for 15minutes and resets automatically.

After you log in, your login name appears on the Personal User Settingsmenu.

How to Log Out of BVD
When you complete your session, it is recommended that you log out to prevent unauthorized entry.

Click Logout on the Personal User Settingsmenu.

Installation and Administration Guide
Color Your Data

HPE OMi Business Value Dashboard (10.10) Page 8 of 109

https://softwaresupport.hp.com/group/softwaresupport/search-result/-/facetsearch/document/KM323488


My Account
TheMy Account dialog box enables individual users to change their name and password. In addition, users
can provide their email address.

The changes made here are also applied to the user's configuration in User Management. For details, see
"User Management" on page 43.

To access

Click My Account on the Personal User Settingsmenu.

Tasks

How to Update My Account Information
1. In theEmail field, enter your email address.
2. In theName field, type a new display name.
3. Click Change Password and enter the old and the new password.

Note: TheChange Password button is not available for LDAP users.

4. Click Change to save your changes.

Installation and Administration Guide
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Get Started

Step 1: Before You Begin
1. Make sure Visio is installed on the system where you plan to create dashboards for BVD.
2. Log into BVD:

a. Access BVD at the following URL:

http://<BVD_server>:<port>/login/

Enter your login name and password.

b. Recommended. Open the Personal User Settings > My Accountmenu and specify a new
password.

3. In BVD, open Administration > System Settings, and copy theAPI Key.
This key identifies your BVD instance andmust be included in the data submitted by the data senders.

Note: The System Settings page is only available to users with administrator privileges.

4. Download the BVD stencil for Visio, the OMi sample dashboard, and the data generator in
Administration > Download Tools & Samples, and install them:
o Visio Stencil

o Sample OMi Status Dashboard

o Data Generator Sample

Installation and Administration Guide
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Step 2: Try the OMi Sample Dashboard
BVD provides the sample dashboardOMi Event and KPI Status Samples (omi_sample) as well as a
batch and a VBScript file for sending data to the example.

1. View theOMi sample dashboard in Dashboards > omi_sample.

You can configure this dashboard in Administration > Manage Dashboards > omi_sample.
Take amoment and look at the properties of the dashboard widgets, the data channels, fields, and
rules.
Alternatively, look through the BVD Getting Started dashboards, which are based on theOMi sample
dashboard and guide you through the process of modifying a Visio file, uploading the exported SVG file
to BVD, and then sending data to the dashboard.

2. Run the data generator samplegen.bat after extracting it from samplegen.zip. When prompted, enter
the URL of your data receiver, your API key, and the HTTP proxy and port, if required.

Example:

Please enter the data receiver URI, e.g. https://receiver.coloryourdata.io/:
http://bvd.example.com:12224/
Please enter your BVD API Key: 47a648e9065d465012e541288b5a345e
Host name of your HTTP proxy server (leave empty if not required):
httpproxy.example.com
Port name of your HTTP proxy server: 8080
Sending sample data to ...

The batch file generates random values and sends them every two seconds to the sample dashboard.

Installation and Administration Guide
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Step 3: Send Your Own Data to the Dashboard
Before creating your first BVD, think about the data you want to send and show. Youmay have numbers
indicating the currently logged-in users of your online banking system, metrics indicating the response time
of your web servers, or measurements of the temperature in your data centers.

BVD expects to receive your data as HTTP post requests in JavaScript Object Notation (JSON) format.

The URL should look something like this:

http(s)://<BVD_server>:<port>/api/submit/<API_key>/dims/<dims>

<BVD_server>

The Fully Qualified Domain Name (FQDN) of the BVD server.

<port>

The port assigned to the BVD receiver during the configuration (default: 12224 or 12225).

<API_key>

Identifies your BVD instance. You can find the API key in Administration > System Settings.

<dims>

The names in your JSON name-value pairs. Select and combine dims that uniquely identify your data.

For more information on the URL of the BVD data receiver, see "Sending dims and tags to the receiver
URL" on page 71.

Example URL:

http://bvd.example.com:12224/api/submit/47a648e9065d465012e541288b5a345e/dims/viewN
ame,ciName,kpiName/tags/omi,kpi

Example data channel in BVD:

Tags: omi, kpi

Dims: OprSample (=viewName), Employee Self Service (=CiName), Unassigned Events
(=kpiName)
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Step 4: Design Your Own Dashboard in Visio
1. In Visio, create a new drawing. Drag and drop the BVD shapes to your drawing and then arrange and

modify them as required.
HPE recommends that you do not change the shape data of the BVD shapes in Visio itself. BVD
enables you to adapt the widgets in the uploaded dashboard, which faster andmore convenient (
Administration > Manage Dashboards).
For an overview of the available widgets and the associated properties, see "Widgets" on page 77.

2. Save your drawing as an SVG file, making sure that the following Visio settings are selected:
o Save as type: Scalable Vector Graphics (*.svg)

o Select: Include Visio data in the files

o Tip: Press Ctrl+A to select everything in the drawing. This ensures that your entire drawing is
exported and not the currently selected element only.

Alternatively, click theExport Dashboard button in theDashboard ribbon, if you have installed the
BVD VisioAddin.

Installation and Administration Guide
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Step 5: Upload your Dashboard to BVD

1. In BVD, open Administration > Manage Dashboards and click + Add, select your SVG file,
and then click Upload Dashboard to import it. The BVD dashboard editor opens and displays your
uploaded dashboard.

2. You can change the properties of the dashboard itself (for example, the SVG file associated with the
dashboard, the title, or the background color).
To edit the properties of a widget, click the widget. When you click theData Channel field, a drop-
down list opens showing all data streams that have been received by BVD. The data you sent in Step
3 should be included in the list. Select it, adjust any of the other properties as required, and click Save.
For more information about the widget properties, see "Widget Properties" on page 86.

3. By default, newly imported dashboards are visible in theDashboardsmenu. To show or hide a
dashboard, click the Show in Menu/Hide from Menu button.

4. View your dashboard by selecting it in the Dashboardsmenu. Then watch your dashboard
updating as you send data over your data channels.
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Installation and Configuration
This section describes how to install and configure BVD.

You can find information about supported operating systems, databases, browsers, as well as coexistence in
the support matrix:

Support Matrices for Operations Center products

Download and extract the support matrix files, open the document SUMA.htm and select Operations
Manager i Business Value Dashboard from the product list.

• Prerequisites 16
• Hardware Requirements 16
• Database Requirements 16
• User Account Requirements 17

• Installation 17
• Preparation 17
• Installation onWindows Systems 17
• Installation on Linux Systems 23
• Silent Installation 24

• Configuration 25
• Configure BVD 25
• Configure the Database 28
• Configure theWeb Server and Receiver 29
• Configure TLS 30
• Configure the License 31
• Configure the Administrator User 31
• Configure the Redis Server 31
• Configure LDAP 32
• Configure Data Aging 32
• Reconfigure BVD 32

• Uninstallation 32
• Uninstallation on aWindows System 33
• Uninstallation on a Linux System 33

• Licensing 34
• License Installation 34
• Updating Operations Bridge Licenses for BVD 35
• Additional License Authorizations for Systems Management Center Products 35

• High Availability 36
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Prerequisites
The hardware, database, and installing user requirements are listed in this guide. For a list of supported
platforms, web browsers, databasemanagement systems, visualization tools as well as coexistence and
virtualization information, see the support matrix:

Support Matrices for Operations Center products

Download and extract the support matrix files, open the document SUMA.htm and select Operations
Manager i Business Value Dashboard from the product list.

Hardware Requirements
l Processor. 2 CPU cores minimum, 4 recommended. All CPU cores must run at 2.4 GHz or faster.
In a virtual environment, make sure the number of virtual CPUs is equivalent to 2 (or 4) physical CPU
cores.

l Disk space. 10GB
l Memory (RAM). 2GB
This section includes:

l "Hardware Requirements" above
l "Database Requirements" below
l "User Account Requirements" on the next page

Database Requirements
When configuring BVD, you can choose between an external PostgreSQL database and an embedded
PostgreSQL database.

There are no specific requirements for the embedded PostgreSQL database other thanmaking sure that you
meet the hardware requirements listed in "Hardware Requirements" above. BVD installs and configures the
embedded PostgreSQL database instance for you on the BVD server.

The requirements for the external PostgreSQL database are as follows:

l Hardware. For PostgreSQL hardware requirements, see the PostgreSQL documentation available at:
http://www.postgresql.org/docs/manuals/

l PostgreSQL version. For a list of supported PostgreSQL database versions, see the support matrix at:
Support Matrices for Operations Center products
Download and extract the support matrix files, open the document SUMA.htm and select Operations
Manager i Business Value Dashboard from the product list.

l Installation. For details on the PostgreSQL software installation, see the installation guide in the
documentation for your specific PostgreSQL version.

Caution: Make sure you configure the pg_hba.conf file on the PostgreSQL server to accept remote
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connections. Otherwise, the connection to the PostgreSQL database cannot be established when
configuring BVD.

l Configuration. A database for use by BVD must already be configured. The name of the databasemust
not be postgres. In addition, the user that accesses the databasemust have permissions to create tables.
For details on connecting BVD to the database, see "Configure the Database" on page 28.

User Account Requirements
l Windows. You need administrative privileges on the host system onwhich you are installing and
configuring BVD.

l Linux. Youmust use the root user account to install and configure BVD.

Installation
This section includes:

l "Preparation" below
l "Installation onWindows Systems" below
l "Installation on Linux Systems" on page 23
l "Silent Installation" on page 24

Preparation
1. Download the following .zip archive file to the system where you want to install BVD:

HPE_BVD_<Version>.zip

2. Extract all files from the archive.
3. Change to the directory that contains the BVD installation files:

HPE_BVD_<Version>

4. Optional for Linux. You can verify that the installation files are original HPE-provided code and have not
beenmanipulated by a third-party by using HPE Public Key and the verification instructions on the
following web site: HPE GPG or RPM Signature Verification

Installation on Windows Systems
1. Make sure no other installations or processes requiringWindows Installer are running.
2. Start the installation by running the following command:

install.bat

The BVD setup begins.
3. Choose the language.

Installation and Administration Guide
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Your installer may offer additional languages. The language that you choose in the language selection
window becomes the language of the installation wizard.

From the drop-down list, select the language that you want to use in the installation wizard, and then
click OK.

Note: Your selection does not affect the following:
o The language of the configuration wizard (it is determined automatically from the operating

system settings).

o The language used in the BVD console.

4. Read the introduction.
The Introduction (Install) page describes the installation wizard. Familiarize yourself with the
information provided and then click Next.
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5. Review the license agreement.
In the License Agreement page, accept the license agreement and click Next to continue with the
installation. If you decline, the installation cannot proceed.
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6. Specify the installation folders:
o Shared content installation folder (default):

C:\Program Files\HP\HP BTO Software\

o Shared content data folder (default):

C:\ProgramData\HP\HP BTO Software\

o Application folder (default):

C:\Program Files\Hewlett Packard Enterprise\BVD\

Referred to as <BVD_Install_Dir> in this documentation.

o Data folder (default):

C:\ProgramData\Hewlett Packard Enterprise\BVD\

Referred to as <BVD_Data_Dir> in this documentation.

Note: If you are installing BVD on a system with shared content already installed (for example, a
system with OMi installed), you cannot select folders for shared content.

Click Next.
7. Review the product requirements.

The installation wizard checks that the systemmeets the requirements for installing BVD.
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In theProduct Requirements page, click Next.

Note: If a requirement check fails, review the warningmessage andmake sure the systemmeets
the product requirements listed in this document. After updating the system resources, click
Previous and thenNext to continue with the installation.

8. Install BVD.
Review the information in thePre-Install Summary page and then click Install to start the installation.
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9. Review the information in the Installation Complete page, for example by clickingView log file.
When you have finished, click Done to close the installation wizard.

10. Configure BVD as described in "Configuration" on page 25.
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Installation on Linux Systems
1. Log in to the server as user root.
2. Start the installation by running the following command:

./install.sh

The BVD setup begins.

Tip: To install BVD from the console, run the installation script with the -console option:
./install.sh -console

Alternatively, unset the $DISPLAY shell environment variable, and run the commandwithout
specifying the -console option.

3. Choose the language.
Your installer may offer additional languages. The language that you choose in the language selection
window becomes the language of the installation wizard.
From the drop-down list, select the language that you want to use in the installation wizard, and then
click OK.

Note: Your selection does not affect the following:
o The language of the configuration wizard (it is determined automatically from the operating

system settings).

o The language used in the BVD console.

4. Read the introduction.
The Introduction (Install) page describes the installation wizard. Familiarize yourself with the
information provided and then click Next.

5. Review the license agreement.
In the License Agreement page, accept the license agreement and click Next to continue with the
installation. If you decline, the installation cannot proceed.

6. Review the product requirements.
The installation wizard checks that the systemmeets the requirements for installing BVD.
In theProduct Requirements page, click Next.

Note: If a requirement check fails, review the warningmessage andmake sure the systemmeets
the product requirements listed in this document. After updating the system resources, click
Previous and thenNext to continue with the installation.

7. Install BVD.
Review the information in thePre-Install Summary page and then click Install to start the installation.

8. Review the information in the Installation Complete page, for example by clickingView log file.
When you have finished, click Done to close the installation wizard.
BVD installs to the following default directories:
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o Shared content installation folder: /opt/OV

o Shared content data folder: /var/opt/OV

o Application directory: /opt/HP/BVD

o Data directory: /var/opt/HP/BVD

9. Configure BVD as described in "Configuration" on the next page.

Silent Installation
The BVD installation wizard can be invoked to run in a silent mode. In this mode, the wizard does not display
a graphical user interface.

1. Create an empty file called ovinstallparams.ini in the same directory as the installation executable
file, for example:
o Windows:

HPE_BVD_<Version>\install.bat
HPE_BVD_<Version>\ovinstallparams.ini

o Linux:

HPE_BVD_<Version>/install.sh
HPE_BVD_<Version>/ovinstallparams.ini

2. Copy the following section to the .ini file on the BVD server:

[installer.properties]
setup=HPEBVD

3. Windows only. To change the default installation directories, add the following lines at the end of the file:

installDir=<SharedComponentsBinaryFilesDirectory>
dataDir=<SharedComponentsDataDirectory>
prodInstallDir=<BVDBinaryFilesDirectory>
prodDataDir=<BVDDataDirectory>

Note: The first two lines apply to the HPE shared data (shared components), and the last two lines
apply to BVD.

4. Run the installation wizard silently by starting the setup file with the -i silent option, for example:
o Windows:

HPE_BVD_<Version>\install.bat -silent

o Linux:

HPE_BVD_<Version>/install.sh -silent

5. Configure BVD as described in "Configuration" on the next page.
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Configuration
This section includes:

• Configure BVD 25
• Configure the Database 28
• Configure theWeb Server and Receiver 29
• Configure TLS 30
• Configure the License 31
• Configure the Administrator User 31
• Configure the Redis Server 31
• Configure LDAP 32
• Configure Data Aging 32
• Reconfigure BVD 32

Configure BVD
1. Open a command prompt or shell.
2. Log in as user with administrator privileges (for example, root on Linux).
3. Create a copy of the sample configuration .ini file:

Windows: <BVD_Install_Dir>\BVD\config_example.ini
Linux: /opt/HP/BVD/config_example.ini

4. Modify the BVD settings in your copy of the configuration .ini file.
The configuration .ini file contains settings for the database, the web server, the BVD data receiver, TLS
usage, license usage, the built-in administrator user, the Redis server, LDAP configuration, and data
aging:
o "Linux Only: Configure BVD to Run Under Non-Root User Account" on page 27

o "Configure the Database" on page 28

o "Configure theWeb Server and Receiver" on page 29

o "Configure TLS" on page 30

o "Licensing" on page 34

o "Configure the Administrator User" on page 31

o "Configure the Redis Server" on page 31
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o "LDAP Authentication andMappings" on page 48

o "Data Aging" on page 97

Note:
o The passwords in the config_example.ini file are example passwords only. When you adapt

your copy of the .ini file to your configuration requirements, make sure to change the example
passwords following your company's password policies. The .ini file contains example
passwords for the following users:
n The user that BVD uses to connect to and retrieve data from the BVD database.
n The database admin user (embedded PostgreSQL database only).
n The built-in BVD super-admin user.
n The user that BVD uses to connect to the Redis in-memory database.

o When defining ports, make sure the ports are not already in use by another application.

5. Run the BVD configuration tool using your configuration .ini file as input:

Windows: "<BVD_Install_Dir>\BVD\bin\configure.bat" -c <configuration_file>.ini

Linux: /opt/HP/BVD/bin/configure.sh -c <configuration_file>.ini

Note:Windows only.Wait for the installation to complete before opening the command prompt for
the configure.bat file. Otherwise the required libraries cannot be found.

6. After the configuration tool completes, verify that the BVD processes are running, type:

ovc -status

The following processes must be running:

bvdaging BVD Aging BVD (2632) Running
bvdpg BVD Postgres DB BVD (3776) Running
bvdrc BVD Receiver BVD (2532) Running
bvdredis BVD Redis Server BVD (3516) Running
bvdsc BVD Sidecar BVD (3840) Running
bvdws BVD Web Server BVD (2576) Running
ovbbccb OV Communication Broker CORE (2600) Running
ovcd OV Control CORE (2492) Running
ovconfd OV Config and Deploy COREXT (3244) Running

7. Optional. Check the configuration log file at:

Windows: <BVD_Data_Dir>\BVD\log\configure.log
Linux: /var/opt/HP/BVD/log/configure.log

8. In a browser, enter the BVD URL:

http(s)://<BVD_server>:<port>/login/

where

<BVD_server> represents the Fully Qualified Domain Name (FQDN) of the system onwhich you
configured BVD; <port> is the port assigned to BVD during the configuration. Example:
http://localhost:80/login

9. Enter your login name and password. Initial access can be gained using the administrator user name and
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password that you specified in the configuration .ini file. See also "Configure the Administrator User" on
page 31.

10. Store the configuration .ini file in a secure place.
After the BVD configuration completes, the .ini file is only needed if you want to reconfigure BVD. See
also "Reconfigure BVD" on page 32.

Caution: As the .ini file contains passwords in plain text, move it to a secure location where only
authorized users can access it.

Linux Only: Configure BVD to Run Under Non-Root User
Account
On Linux, the BVD and associated processes by default run under the root user account. You can change the
user account that is associated with the processes to another user by specifying the following [NonRoot]
parameters in the BVD configuration .ini file.

The following processes are affected:

l BVD processes
l Operations agent core processes (ovbbccb, ovcd, ovconfd)

Note: On Linux servers, non-root users cannot open ports in the range 0 to 1023. Youmust therefore
specify ports above 1023 for the BVD web server.

Alternatively, you can use the Linux setcap utility to set file capabilities that are extended attributes on
the BVD web server process; for example: setcap 'cap_net_bind_service=+ep'
/opt/HP/BVD/node/node

username

User account under which the processes will run. BVD will create the user account if does not yet exist.
Leave empty to run BVD under root user account.

group

Group account of the user under which BVD will run. BVD will create the group account if does not yet
exist. Leave empty to run BVD under root group account.
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Configure the Database
Complete the following parameters in the [Database] section of the BVD configuration .ini file to define how
the database will be configured.

Note: Before connecting to an external PostgreSQL database, make sure the database is installed as
required by BVD. For details, see "Database Requirements" on page 16.

type

The type of database to be used:

postgres: for use with an external PostgreSQL database.

internal: for use with the embedded PostgreSQL database.

Default: internal

host

External database only. The name of the host machine on which PostgreSQL is installed.

Default: localhost for the embedded database

database

External database only. The name of a PostgreSQL database that already exists. The database name
must not be postgres.

Default: bvd for the embedded database

port

The PostgreSQL listening port.

Default: 5432.

username

The name of a user that BVD uses to connect to and retrieve data from the BVD database. The user must
have permissions to create tables in the database.

Default: pg_user

password

The password of the user.

Default: pg_user

adminuser

Embedded database only. The name of a user with administrative permissions on the embedded
PostgreSQL database.

Default: pg_admin

adminpassword

Embedded database only. The password of the administrative user.

Default: pg_admin
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Configure the Web Server and Receiver
Complete the following parameters in the [WebServer] and [Receiver] sections of the BVD configuration
.ini file to configure the web server and receiver.

For more information on the TLS parameters, see "Configure TLS" on the next page.

port

HTTP port of the web server/receiver.

Default: 80 (web server), 12224 (receiver)

usessl

Enables or disables TLS for the web server/receiver. If set to true, youmust also specify the sslport
parameter for the TLS port .

Default: false

sslport

TLS port of the web server/receiver.

Default: 443 (web server), 12225 (receiver)
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Configure TLS
You can configure the BVD web server or the BVD receiver or both to support secure connections only.
Complete the following steps to configure BVD for TLS:

1. Obtain a server certificate from your certificate authority (CA). Make sure the certificate is issued to the
FQDN of your BVD server. BVD supports certificates in PEM or PFX format.

2. Place the certificates in the file system on your BVD server andmake sure the certificates are readable
by theWindows SYSTEM user or, on Linux, by the user under whose account the BVD processes are
running (default: root).

3. Complete the following parameters in the BVD configuration .ini file to define the TLS setup:
o Enable TLS for theBVD web server in the [WebServer] section:

usessl

Set to true to enable TLS for the BVD web server.

sslport

Secure port of the BVD web server. Default: 443

o Enable TLS for theBVD receiver in the [Receiver] section:

usessl

Set to true to enable TLS for the BVD receiver.

sslport

Secure port of the BVD receiver. Default: 12225

o You can provide BVD with the required certificates in the following ways:
Certificate and key:

certificate

Specify the filename of the certificate. The certificate must be an X.509 certificate in PEM format.
Example: certificate.pem

key

Private key of the certificate. Example: key.pem

PFX file:

pfx
Container file with the certificate, private key, and CA certificates, in PFX format. Example:
certificate.pfx

If the key or .pfx file is encrypted, specify the passphrase:

passphrase

Optional. Passphrase used to encrypt the key or .pfx file.

4. Run the BVD configuration tool using your configuration .ini file as input:

Windows: "<BVD_Install_Dir>\BVD\bin\configure.bat" -c <configuration_file>.ini

Linux: /opt/HP/BVD/bin/configure.sh -c <configuration_file>.ini
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5. After the configuration tool completes, verify that the BVD processes are running, type:

ovc -status

Configure the License
For details on configuring licensing for BVD, see "Licensing" on page 34.

Configure the Administrator User
One built-in super-admin user is defined for every installation of BVD. The login and the password for this
account are specified in the [Administrator] section of the configuration .ini file.

Note: BVD supports central user management and corporate password policies by connecting BVD to
an LDAP repository. HPE recommends that you connect BVD to LDAP to ensure that users handle their
passwords in compliance with the security standards of your company. You can configure the LDAP
integration in the [LDAP] section of the configuration .ini file. If you want to authenticate all users against
the LDAP repository, disable mixed-mode authentication. For more information on the LDAP integration,
see "LDAP Authentication andMappings" on page 48.

name

Login name of the built-in BVD super-admin.

The built-in super-admin is not listed among the users in user management. If you have logged in as the
super-admin, you can change the user's information, including password and contact information in the
My Account page in the Personal User Settingsmenu.

Default: admin

password

Password of the built-in super-admin.

Default: admin

Configure the Redis Server
BVD installs and uses a Redis in-memory database. You can define the port and password connection
parameters as follows:

port

Port on which Redis accepts connections.

Default: 6379

password

Password required for connections to Redis.

Default: bvd_redis
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Configure LDAP
For details on configuring an LDAP server for BVD user authentication, see "LDAP Authentication and
Mappings" on page 48.

Configure Data Aging
By default, up to 500 data records per data channel are stored in the database. You canmodify the default and
adjust additional data aging parameters as described in "Data Aging" on page 97.

Reconfigure BVD
If—at a later time—youwant to modify any of the configuration parameters, you can start the configuration
tool again:

1. Embedded PostgreSQL database only. Before reconfiguring BVD, make sure that there are no additional
connections to the embedded PostgreSQL database except for the connection from BVD.

2. Modify the configuration .ini file that was used for the previous configuration.
3. Run the BVD configuration tool using themodified configuration .ini file as input:

Windows: "<BVD_Install_Dir>\BVD\bin\configure.bat" -c <configuration_file>.ini

Linux: /opt/HP/BVD/bin/configure.sh -c <configuration_file>.ini

4. After the configuration tool completes, verify that the BVD processes are running, type:

ovc -status

Uninstallation
Uninstall BVD using the installation wizard.

This section includes:

l "Uninstallation on aWindows System" on the next page
l "Uninstallation on a Linux System" on the next page
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Uninstallation on a Windows System
1. Navigate to the folder that contains the installation file and double-click HPEBVD_<Version>_setup.exe.

The BVD installation wizard starts.
Alternatively, use theWindows Control Panel to start the installation wizard.

2. In theMaintenance Selection page, click Uninstall and thenNext.
Follow the wizard instructions when prompted.

3. If the following folders have not been removed by the uninstallation, remove themmanually:
o Application folder (default):

C:\Program Files\Hewlett Packard Enterprise\BVD\

o Data folder (default):

C:\ProgramData\Hewlett Packard Enterprise\BVD\

Caution: Remove the following folders only if BVD was the only HPE Software application on the
system:
o Shared content installation folder (default):

C:\Program Files\HP\HP BTO Software\

o Shared content data folder (default):

C:\ProgramData\HP\HP BTO Software\

Uninstallation on a Linux System
1. Navigate to the folder that contains the installation file and type the following command to start the

installation wizard:

./HPEBVD_<Version>_setup.bin -uninstall

2. In theMaintenance Selection page, click Uninstall and thenNext.
Follow the wizard instructions when prompted.

3. If the following directories have not been removed by the uninstallation, remove themmanually:
o Application directory: /opt/HP/BVD

o Data directory: /var/opt/HP/BVD

Caution: Remove the following directories only if BVD was the only HPE Software application on
the system:
o Shared content installation folder: /opt/OV

o Shared content data folder: /var/opt/OV
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Licensing
BVD is licensed with the Operations Bridge Premium and Ultimate Edition suites. The number of dashboards
you are entitled to create depends on the number of nodes licensed with the Operations Bridge licenses. You
install your Operations Bridge license using the BVD configuration .ini file as described in "License
Installation" below.

If you do not have anOperations Bridge license yet, you can use BVD with the 60-day Evaluation license,
which entitles you to up to 10 dashboards. To use the Evaluation license, leave the file parameter in the
[License] section of the .ini file empty. The Evaluation license cannot be renewed.

For more information on licensing in OMi, seeAdministration Guide > Setup and Maintenance > License
Management in the OMi Administration Guide or Online Help.

This section includes:

l "License Installation" below
l "Updating Operations Bridge Licenses for BVD" on the next page
l "Additional License Authorizations for Systems Management Center Products" on the next page

License Installation
To install the license for BVD, complete the following steps:

1. Obtain the Operations Bridge license file from theOMi administrator or from HPE. For details on
updating existing Operations Bridge licenses, see "Updating Operations Bridge Licenses for BVD" on
the next page.

Place the license file in the file system on your BVD server. The license file has the .dat file name
extension.

2. In the [License] section of the configuration .ini file, add the path and name of the license file to the
file parameter:

file

Path and name of the .dat license file. If this parameter is empty, the 60-day evaluation license is
installed.

3. Run the BVD configuration tool using your configuration .ini file as input:

Windows: "<BVD_Install_Dir>\BVD\bin\configure.bat" -c <configuration_file>.ini

Linux: /opt/HP/BVD/bin/configure.sh -c <configuration_file>.ini

4. After the configuration tool completes, verify that the BVD processes are running, type:

ovc -status

BVD posts a license notification when the license has expired or when the number of configured dashboards
exceeds the allowed number. You can look up license information such as the license expiration date in the

Help > About page.
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Updating Operations Bridge Licenses for BVD
If you purchased anOperations Bridge license before OMi version 10.10, you need to retrieve and activate a
new, up-to-date license in order to use BVD. To do so, perform the following:

1. Retrieve your up-to-date license in theHPE My Software Updates portal:
https://www.hpe.com/software/updates

2. Activate the license in theHPE Licensing for Software portal: https://h30580.www3.hp.com
3. Install the new license by following the steps in "License Installation" on the previous page.
If you purchased anOMi Event Foundation license, you can continue using your license, but you will not be
able to use BVD. To be entitled to the use of BVD, you can exchange your old license for a new license in the
new Operations Bridge licensing structure. For more information, contact your sales representative to
discuss your options.

Additional License Authorizations for Systems
Management Center Products
For details on the content of the individual Operations Bridge suites, see the Additional License
Authorizations for HPE Systems Management Center software products.

For themost up-to-date version, go to http://support.openview.hp.com/contracts_licensing.jsp. In the
Additional license authorizations for Enterprise Security, Information Management, IT Management
and Vertica software products table cell, click English (.PDF). Download and open the resulting PDF
document and scroll down to theSystems Management Center Products section to find the suite you
would like to learnmore about. Click the number to the right of the product name to download the
corresponding Additional License Authorizations.
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High Availability
You can improve your system availability and reliability
using high availability options that combinemultiple
BVD servers, external load balancing, and failover
procedures.

Implementing a high availability configurationmeans
setting up your BVD servers so that service is
continuous despite power outages or system
downtime.

The figure describes a BVD high availability setup with
a primary and a backup BVD server, both connected to
the same external PostgreSQL database. A load
balancer handles the incoming BVD connections.
During failover, the backup server is started and the
load balancer redirects the BVD connections to the
backup server.

Because BVD stores its configuration and dashboard
data in the database and both servers access the
same database, no additional synchronization tasks are required. However, immediately after the failover,
the list of available data channels in the widget properties may be empty. The list will be populated again as
data arrives at the backup server, redirected through the load balancer.

This section includes:

l "Prerequisites" below
l "How to set up high availability for BVD" below
l "How to initiate a failover" on the next page

Prerequisites
l Remote PostgreSQL database. BVD uses a remote PostgreSQL database. (BVD with an embedded
PostgreSQL database does not support a high availability setup.)

l Load balancer. All connections to BVD must be handled by a load balancer. Configure the load balancer
to handle connections from both the primary and the backup BVD server. The primary server should be
registered as primary, the backup server as secondary server. When the primary server fails, the load
balancer automatically redirects the connections to the backup server.

l Backup BVD server. In addition to the primary BVD server a backup server must be configured and
connected to the same database as the primary server.

How to set up high availability for BVD
1. Configure the load balancer for data provider and user access as follows:

o Configure the load balancer for data provider access.
All data providers must be able to access the virtual IP of the load balancer. Use the standard
settings for the load balancer, but set the following:
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n Persistence. Set persistence to IP based stickiness or destination address affinity (depending
on the load balancer). If neither of these options are available and the choice is between cookie
based stickiness and stickiness by session enabled, then we recommend trying stickiness by
session enabled.

n Priority activation. Configure a priority or weight for the primary and backup BVD servers. The
primary server should be assigned the highest priority number, the backup server the next higher
priority. The load balancer distributes all BVD traffic to the server with the highest priority, that is
the primary server. When the primary server becomes unavailable, the load balancer sends all
traffic to the server with the next higher priority, that is the backup server.

o Configure the load balancer for user access.
Use the standard settings for the load balancer, but set the following:
n Persistence. Use the standard settings for the load balancer, but set persistence to stickiness

by session enabled or destination address affinity (depending on the load balancer). If neither
of these options are available and the choice is between cookie based stickiness and IP based
stickiness, then we recommend trying IP based stickiness. If this is not done properly, youmay
experience intermittent user interface failures.

2. Install BVD on the backup server. For details, see "Installation" on page 17.

Note: There is no need to stop BVD on the primary server during the installation of the backup
server.

3. Configure BVD on the backup server. During the configuration, connect BVD to the same remote
PostgreSQL database to which the primary server is connected.

Tip: Use the same configuration .ini file that was used to configure the primary BVD server.

For details, see "Configuration" on page 25.
4. Stop BVD after the configuration completes:

ovc -stop BVD

How to initiate a failover
1. When the primary BVD server fails, start the backup server:

ovc -start BVD

2. Users will lose their BVD browser session andmust log in again.
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Administration
This section describes the administration areas of BVD.

• System Settings 38
• DashboardManagement 39
• UserManagement 43
• LDAP Authentication andMappings 48
• Download Tools and Samples 54

System Settings
The System Settings page displays your API key and enables you to change the look and feel of your
dashboards and BVD using a custom style sheet.

To access

Administration > System Settings

Learn More

API Key
The API key connects your BVD data to your BVD instance. The key must be included in all of you data
streams and ensures that your data arrives in your dashboards.

You can request a new API key, for example if your old key has been compromised. To request a new key,
click Request New API Key in the System Settings page. BVD displays your new key immediately.
Remember to update your data senders to include your new API key.

Style Customization
You can change the look and feel of BVD, for example, the color of themasthead. To do so, inspect the
HTML element that you want to change, type the new style in theStyle customization field and click
Upload changed style.
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See also "Use Custom Fonts in Your Dashboards" below for detailed instructions on how to choose a web
font other thanGoogle Fonts for your dashboards.

Do It Yourself

Use Custom Fonts in Your Dashboards
BVD dashboards by default use fonts served by Google at http://www.google.com/fonts. To use custom
fonts for your dashboards, do the following:

1. Use your preferred fonts in the Visio drawings of your dashboards, open the exported SVG file in a text
editor, and then search for the string font. In SVG files, fonts are declared in CSS definitions similar to
the following:

Take note of the font family name, for example Metric.
2. Make sure your custom fonts are installed on a publicly accessible web server.

The web server must allow access to the font resources from other sites. To do so, it must include a
properly configured Access-Control-Allow-Origin header in each reply to a font request.

3. Create a custom CSS font definition in BVD:

Open Administration > System Settings and type your CSS definition in theStyle customization
field, then click Upload changed style.

Example:

@font-face {
   font-family: "Metric";
   src: url("https://www.example.com/fonts/metric.woff") format("woff");
}

Dashboard Management
TheManage Dashboard page lists all available dashboards, and enables you to upload, delete, download,
edit, or show or hide dashboards in the dashboards menu.

To access

Administration > Manage Dashboards
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Learn More
This section includes:

l "Dashboard Icons" below
l "Uploading Dashboards" below
l "Downloading Dashboards" on the next page
l "Categorizing Dashboards" on the next page
l "Changing the Title of a Dashboard" on page 42
l "SelectingWidgets for Editing" on page 43

Dashboard Icons
Use these buttons tomanage your dashboards as follows:

+ Upload a dashboard from an SVG file.

Delete a dashboard from BVD.

Download a dashboard to an SVG file.

Note: The Download button is not available when working with BVD onmobile devices.

Edit a dashboard in BVD.

Show or hide a dashboard in the Dashboardsmenu.

Tip: Onmobile devices, click the buttons twice to trigger their actions.

The following icons notify you of missing or incorrect configurations when editing a dashboard:

Not all required fields of the widget have been completed; for example, the data channel has not
been selected yet. You can save dashboards that have warnings.

The widget configuration contains errors (for example, incorrect color values, incorrect HTTP
protocol in web page widgets, and so on). Youmust first resolve the errors before the dashboard
can be saved.

The widget has unsaved changes.

Uploading Dashboards
You can upload an SVG file as often as you want. Edit the dashboard, and in the dashboard properties click

Replace Dashboard. If the file already exists, BVD replaces the previous version of the file with the
newer version and opens the associated dashboard for you to edit. The newer version does not overwrite
existing dashboard properties or widgets, only new widgets are added.

Deleting widgets from an SVG file only deletes the widgets from the dashboard. The configuration of the
deleted widgets remains in the database so that you can easily re-upload a previous version of an SVG file to
reactivate the previously deleted widgets.
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Downloading Dashboards
When you upload an SVG file created from Visio, the SVG file usually does not have any data channels
configured. This task is best done in the BVD Manage Dashboards UI.

To obtain a version of your SVG files with the data channels configured, you can download the dashboards
from BVD using the Download button in theManage Dashboards UI. The download creates an SVG file
with the original name.

You can then transfer this file to another BVD instance and upload it there, or store it in a safe location for
backup purposes.

Categorizing Dashboards

To be able to grant dashboard permissions to a user, a
dashboardmust have one or more categories assigned.
Categories are arbitrary text strings that you enter in the
Categories field in the dashboard properties. Once
entered, a category can be selected and added to any
dashboard.

When you create a user role, you can assign view or full
control permissions to a dashboard category. This
restricts a user's access to dashboards of the specified
category. See also "How to Set Permissions" on
page 47.
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Changing the Title of a Dashboard

When you upload an SVG file, the file name automatically
becomes the title of the dashboard. This behavior canmake the

Dashboards drop-downmenu look very technical:

Consider changing the title of your dashboards in the
dashboard's properties:

Administration > Manage Dashboards > Edit

In the Title field, enter a descriptive name.
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Selecting Widgets for Editing
To edit the properties of a widget, edit the dashboard that contains the widget and then click the widget. The
properties are displayed to the right of the dashboard for you to edit. When done, click Apply orSave.

If your dashboard contains widgets that are stacked on top of each other so that you cannot access the ones
below, do one of the following:

l Two widgets. If there are only two widgets stacked on top of each other, click the top one once and once
again. The second click selects the one below.

l More than two widgets. If you have a stack of more than two widgets, go the dashboard properties, and
underWidgets click Select a widget for configuration to open a list of available widgets:

Select the widget you want to edit to access the widget's properties.

User Management
Use theUser Management page to create users and groups and to define roles and permissions. To reduce
the effort and complexity involved in configuring roles for individual users in BVD, permissions are granted
only through roles.

You can specify roles either by assigning them to a group (so that all members of the group are assigned the
same roles) or by assigning roles to a user directly. The user and group configuration depends on the
functions the user or group of users fulfill, as well as the tasks that they perform.

For a suggested workflow and overview of the steps involved in setting up users, groups, and roles, see
"Best Practices" on the next page.

For a step-by-step description of the tasks you can perform through user management, see "Tasks" on
page 45.

To access

Administration > User Management
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Learn More
This section includes:

l "Best Practices" below
l "Roles and Permissions" below
l "Users andGroups" on the next page
l "Super-Admin User" on the next page
l "LDAP Users" on the next page

Best Practices
Below is a set of planning best-practices and a suggested workflow for setting up user management in BVD:

1. Before you configure users, groups, and roles, you shouldmap out the required roles and their relevant
permissions, as well as the users and groups you intend to assign the roles to. For example, enter the
following information in an Excel sheet:
a. A list of users who are to access BVD, edit, and create dashboards. Gather appropriate user details

such as user names, logins, and initial passwords. Although not needed to define users, at this stage
it might be useful to also collect user contact information such as email addresses.

b. If multiple users require similar permissions, create a list of groups, and the users that should belong
to each group.

c. The appropriate permissions for each role. To aid in this process, review the Permissions Reference
section to learn about dashboard categories and resources for which permissions can be granted. For
details, see "Permissions Reference" on page 48.

2. Create roles and assign relevant permissions.
For step-by-step instructions on how to create and configure a role, see "How to Create Roles" on
page 46.

3. Create groups and grant them the appropriate roles.
For step-by-step instructions on how to create a group, see "How to Create Groups" on page 46.

4. Create users, grant them the appropriate roles and place them in the appropriate groups.
For step-by-step instructions on how to create a user, see "How to Create Users" on page 46.

Roles and Permissions
BVD enables you to fine-tune permissions management by applying permissions within roles. Permissions
enable you to restrict the scope of a role. You can assign roles to users and groups enabling access to
specific areas of BVD.

Permissions consist of resources, for example, Dashboards, to which operations, for exampleView, are
applied.

l When theView operation is one of the resource's available operations and you select one of the other
available operations, theView operation is also automatically selected.

l The Full Control operation automatically includes all operations available on the resource. When applied,
the other operations are automatically selected.
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For a list of available resources and descriptions of operations in BVD, see "Permissions Reference" on
page 48.

Users andGroups

l Groups. Groups makemanaging roles more efficient; instead of assigning roles to each user one at a
time, you can group users who are assigned the same roles into a single unit.

l User Types. BVD supports different user types:
Users with the appropriate dashboard permissions can view, edit, or create dashboards. They can
download tools and samples to aid in the development of dashboards and the integration of data. Users

with edit permissions can view the Error Notifications icon on themenu bar. This icon is useful when
binding dashboards to data sources. Clicking the icon displays the error list.
Administrator users (users with super-admin permissions) have the following capabilities:
o Full control and view on all dashboards.

o Manage users, groups, and roles, including the creation and deletion of dashboard categories.

o Apply custom style sheets and reset API keys in the BVD system settings.

Super-Admin User
One built-in super-admin user is defined for every installation of BVD. The login and the password for this
account are specified during the BVD configuration.

The built-in super-admin is not listed among the users in user management. If you have logged in as the
super-admin, you can change the user's information, including password and contact information in theMy
Account page in the Personal User Settingsmenu.

You can apply Super-Admin permissions to other users in the system. These super-admin users can be
modified in user management. For information on how to grant super-admin status to a user, see "How to
Create Users" on the next page.

Note: Super-admins have all permissions assigned and are the only user type that can work with user
management and system settings.

LDAP Users
To obtain more user management capabilities and security, we recommend using external LDAP user
management. You can apply the LDAP User type when creating or editing users tomanually configure them
as LDAP users. LDAP users will be authenticated against the chosen LDAP server. For information on how
to configure BVD to work with LDAP, see "LDAP Authentication andMappings" on page 48.

Tasks
This section includes:

l "How to Create Users" on the next page
l "How to Create Groups" on the next page
l "How to Create Roles" on the next page
l "How to Set Permissions" on page 47
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How to Create Users
1. Click Create New User on the user management screen.

Alternatively, access theManage Users pane and select New User.
2. In the Properties section, enter the required user name, login, password, and optional email.
3. Optional. If LDAP is enabled, you can select the LDAP User check box tomark the user as amanually-

created LDAP user. For information on LDAP, see "LDAP Authentication andMappings" on page 48.
4. Select the groups the user will be amember of.
5. Assign roles or (optional) set the user as a Super-admin with all permissions assigned. When finished,

click Create User. For information on the Super-admin user type, see "Super-Admin User" on the
previous page.

The user's basic information, as well as groups they belong to and roles assigned and inherited from groups,
now appears on the right of theManage Users pane when selecting the user.

To delete existing users, selectManage Users, select one or more users you want to delete, and click the
Delete User or Users button.

Tip: In theManage Users pane ( Administration > User Management), you can click the
Deactivate button to apply the Inactive User flag to users who are set to be temporarily inactive, for
example, while the administrator is setting up roles and groups or if the user is on vacation or leave.
Inactive users cannot log on to BVD.

How to Create Groups
1. Click Create New Group on the user management screen.

Alternatively, access theManage Groups pane and select New Group.
2. In the Properties section, enter the required group name and optional description.
3. Optional. If LDAP is enabled, you can search for and select the LDAP groups that aremapped to the

BVD group. For information on LDAP, see "LDAP Authentication andMappings" on page 48.
4. Add groupmembers and assign roles in the relevant sections of the group editor. When finished, select

Create Group.

Tip: You can select multiple users to add to the group by clicking the ... button next to theAdd
user... field. TheSelect Users editor opens. Select a single user, and then hold down theCtrl key
while you click other users that you want to select.
When working with BVD on amobile device, make sure to click a user twice to select it.

The group's basic information, including roles assigned, now appears on the right of theManageGroups pane
when selecting the group. You can also navigate between groups in the group's information pane.

To delete existing groups go to theManage Groups pane, select one or more groups you want to delete, and
click the Delete Group or Groups button.

How to Create Roles
1. Click Create New Role on the user management screen.

Alternatively, access theManage Roles pane and select New Role.
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2. In the Properties section, enter the required role name and optional description.
3. InPermissions, you can select the relevant category and set the appropriate permissions by checking

the related boxes, or use the drop-downmenus on each permission summary.
For a list of permissions and related descriptions see "Permissions Reference" on the next page.
For a detailed task on setting permissions, see "How to Set Permissions" below.
If you have already created users or groups, you can assign them during role creation or editing. When
finished, select Create Role.

To delete existing roles, selectManage Roles, select one or more roles you want to delete, and click the
Delete Role or Roles button.

Note:When there aremore than 1000 users in the system, the user search box is no longer displayed.
Click the ... button to access the user list and search filter dialog box.

How to Set Permissions
In this task, you set or modify the permissions in BVD roles. Users require permissions to view, edit, or
create BVD dashboards.

1. In theUser Management page or in theManage Roles page, create or edit the role you want to
configure.

2. Scroll to the permissions section in theCreate Role orEdit Role page.
3. ExpandDashboards > Categories and assign an operation to one or more dashboard categories:

o All. To grant permissions to all dashboards regardless of the category, click View or Full Control for
All.

o Assigned to category. To grant permissions to all dashboards with any category, click View or Full
Control forAssigned to category.
Alternatively, to grant access to individual dashboard categories, select the appropriate category.

o Not assigned to category. To grant permissions to all dashboards without a category, click View or
Full Control forNot assigned to category.

4. Click Manage Categories to add new categories to the permissions list. You can also delete categories
from the list if they are no longer needed.

Note: Changes to a user account are only fully available after the user whose account was changed logs
in again to BVD.
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Permissions Reference

Dashboards

Categories All Grants view or full control permission for all dashboards
(with or without categories assigned).

Full control onAll grants the following additional
permissions:

l Upload dashboards.
l Delete dashboards.
l Create and delete categories, and assign categories to
dashboards.

l Download tools and samples from the
Administrationmenu.

Assigned to
category
<category>

Not assigned to
category

View Grants permission to:

l View dashboards in the
Dashboardsmenu.

l Make a dashboard the
default dashboard.

Full Control l Edit dashboards in the
Manage Dashboards
page.

l Show or hide dashboards in
the Dashboardsmenu.

l Download dashboards.

LDAP Authentication and Mappings
Automatic user creation from LDAP servers andmapping groups in BVD simplifies the user management
process for administrators as authentication is performed through the LDAP server.
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Learn More
This section includes:

l "LDAP Authentication Overview" below
l "Permissions" below
l "LDAP SetupWorkflows" on the next page

o "Workflow: LDAP User Authentication, Automatic User Creation, Automatic GroupMapping" on the
next page

o "Workflow: LDAP User Authentication Only (No User Creation and NoGroupMapping)" on the next
page

o "Workflow: MixedMode Authentication" on the next page

l "Managing Users" on page 51

LDAP Authentication Overview
You can use an external LDAP server to store user information (user names and passwords) for
authentication purposes, instead of using the internal BVD service. You canmanually create BVD users and
LDAP users, and use LDAP servers to automatically create LDAP users in BVD andmap LDAP groups to
groups in BVD.

For optimal performance, it is recommended that LDAP servers be in the same subnet as the BVD server.

For optimal security, it is recommended to either configure a TLS connection between the BVD server and the
LDAP server, or to have the BVD server and the LDAP servers on the same secure internal network
segment. Authentication is performed by the LDAP server, and authorization is handled by the BVD server.

You configure the LDAP server for authentication and automatic user creation using the BVD configuration
.ini file. For details, see "How to Configure the Connection to the LDAP Server" on page 51.

Permissions
BVD users can automatically get all permissions that are assigned to BVD groups when amapping between
the LDAP groups and the BVD groups has been previously established. When the user logs in the first time,
the LDAP group is used to identify themapped BVD group. The user then automatically gets all permissions
that are assigned to the group.

LDAP users who do not yet exist in BVD, are created as BVD users. Their permissions are determined as
follows:

l If the users belong to amapped LDAP group, they automatically get the permissions assigned to the BVD
group that is mapped to their LDAP group, as set in BVD UserManagement.

l If their group is not mapped to a BVD group, or if they do not belong to an LDAP group, they are created as
a BVD user with no groupmapping and therefore no permissions. Login of such users to BVD is
successful but no dashboards are visible in BVD due to themissing permissions.

If users aremoved between LDAP groups mapped to BVD groups, their permissions change according to the
roles assigned to themapped BVD groups.
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LDAP Setup Workflows
The following section contains overviews of user management processes when LDAP is enabled:

Workflow: LDAP User Authentication, Automatic User Creation, Automatic Group
Mapping
l The BVD administrator uses the BVD configuration .ini file to configure an LDAP server connection and
enable automatic creation of users. In addition, the BVD administrator maps BVD groups to LDAP groups
in BVD UserManagement.

l The BVD user logs on to BVD with their login name or email address and their company password (defined
in the LDAP server). The domain name is the unique identifier of an LDAP connection.

l The BVD server authenticates the user with the LDAP server, creates the user, gets the group
membership from the LDAP server and identifies the corresponding BVD groups that have beenmapped.

Note:When setting up LDAP configurations in BVD, ensure that no local BVD user exists that has the
same login name as the unique ID attribute (for example, sAMAccountName or email) of an LDAP user. If
such a local user already exists, the LDAP user will not be automatically created and will not be able to
log in to BVD.

Workflow: LDAP User Authentication Only (No User Creation and No Group Mapping)
l The BVD administrator uses the BVD configuration .ini file to configure an LDAP server connection and to
disable automatic creation of users. In addition, no BVD groups aremapped to LDAP groups in BVD User
Management.
The BVD administrator creates a new user with the LDAP User check box selected and with the unique
identifier as the login name (or any other unique LDAP ID that has been configured), manually assigns
roles to the user, and places them in groups.

l The LDAP or BVD-LDAP user logs in to BVD with their domain name and/or email address as the login
name and their company password (defined in the LDAP server).

l The BVD server authenticates the user against the LDAP server.

Workflow: Mixed Mode Authentication
l Mixedmode is enabled by default in the BVD configuration .ini file.
l The BVD administrator configures an LDAP server connection and optionally enables automatic creation
of users.

l A BVD user logs in to BVD. An LDAP user logs in to BVD.
l BVD authenticates the users against LDAP and, if this is not successful, against BVD. With mixedmode
disabled, BVD users that are not flagged as LDAP users are not able to log in to BVD.

Note: Mixedmode authentication can be disabled for hardening purposes in the BVD configuration .ini
file, either when configuring BVD for the first time or when reconfiguring BVD. When you disable mixed
mode during the initial configuration of BVD, the built-in super-admin is created as LDAP user. When you
disable mixedmode after the initial configuration, the built-in super-admin is authenticated against BVD
(you canmanually create additional LDAP super-admins).
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When you disable mixedmode after the initial configuration of BVD, the super-admin built into BVD
becomes an LDAP user and the configuration tries to authenticate this user against the LDAP server.
Therefore, youmust make sure that the name and password that is specified in the [Administrator]
section in the configuration .ini file exists on the LDAP server; if not, the configuration will fail. See also
"Configure the Administrator User" on page 31.

Managing Users
To view LDAP users in BVD, click Manage Users on themain BVD UserManagement page. LDAP users

aremarked by the icon.

Matching the Users Search Filter
To log into BVD, an LDAP user must match the values of the searchBase and searchFilter parameters
defined in the BVD configuration .ini file.

Any new LDAP user who satisfies the users search filter and authenticates successfully with the LDAP
password will be created as a BVD user on first login. Ask your LDAP administrator to help you narrow down
the filter definition so that only appropriate users can gain access to BVD.

Obsolete Users
Users that have been removed from the LDAP server are still displayed as BVD users, even though they are
no longer registered as LDAP users and cannot log in to BVD.

Tasks
This section includes:

l "How to Configure the Connection to the LDAP Server" below
l "How toMapGroups Configured in BVD to Groups Configured on the LDAP Server" on page 54

How to Configure the Connection to the LDAP Server
You configure the LDAP server for authentication and automatic user creation using the BVD configuration
tool:

1. Edit the BVD configuration .ini file. A sample configuration .ini file is provided in the following location:

Windows: <BVD_Install_Dir>\BVD\config_example.ini
Linux: /opt/HP/BVD/config_example.ini

2. In the [LDAP] section, complete the following settings:

enabled

Set to true to enable LDAP authentication; set to false to disable LDAP authentication. (If the
parameter is missing, LDAP is enabled and youmust complete the following parameters.)
Default: false

domain

Required. Specify the LDAP domain used to uniquely identify the LDAP server connection.
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Example:
If you specify emea, users will be able to log in to BVD in the format emea\janedoe.
Alternatively, users can log in using themail address format, for example,
jane.doe@example.com. In the case of email addresses, the domain suffix (example.com) has
to be chosen as the unique domain name.

url

Required. The URL to the LDAP server including the port number.

The required format is: ldap(s)://<LDAP_FQDN>:<port>
LDAP servers typically use port 389 or secure port 636.

Example:
url=ldap://192.0.2.24:389

bindDn

Required. Defines the Distinguished Name (DN) of a user with search privileges on the LDAP
directory server.

Note: Some LDAP servers allow anonymous search.

Example:
bindDn=CN=Administrator,CN=Users,DC=hpe,DC=com

Leave this entry blank for an anonymous user.

bindCredentials

Required. Defines the password of the user entitled to search the LDAP server entities.
Leave this entry blank for an anonymous user.

bindProperty

Optional.When an LDAP user tries to log on, the search-entitled user specified in bindDn searches
the LDAP server entities for that user. When found, the user is authenticated against LDAP based on
one of the user's LDAP properties, by default the dn property. You can use the bindProperty
parameter to specify another user property to use for authentication (for example, sAMAccountName
or email).

Example:
bindProperty=dn

searchBase

Required. The Distinguished Name (DN) of the LDAP entity from which you want to start your user
search.

Example:
searchBase=CN=Users,DC=omi,DC=hpe,DC=com

searchFilter

Required. Enter the relevant parameters to indicate which attributes are to be included in the user
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search.

Note:
Youmust use the literal {{username}} to search for the given login name.
BVD by default uses the ??sub scope; other scopes are not supported.

Example:
searchFilter=(cn={{username}})

searchFilter=(sAMAccountName={{username}})

groupSearchBase

Required. The Distinguished Name (DN) of the LDAP entity from which you want to start your
groups search.

Example:
groupSearchBase=CN=Groups,DC=hpe,DC=com

groupSearchFilter

Required. Enter the relevant parameters to indicate which attributes are to be included in the groups
search.

You can configure the search attribute in the groupDnProperty setting.

Note:
o Youmust use the literal {{dn}} to search for groupmembers with a given distinguished

name.

o BVD does not support dynamic LDAP groups. Dynamic groups are therefore ignored in
groups search.

Example:
groupSearchFilter=(member={{dn}})

groupDnProperty

Optional. By default, the LDAP user property dn is used to identify users in groups. You can use the
groupDnProperty setting to specify other properties.

Example:
groupDnProperty=dn

tlsCA

Required with LDAPS only. This parameter is only required if the secure LDAP (LDAPS) protocol is
used for communication with the LDAP server. Specify a comma-separated list of trusted CA
certificate files. The certificate files must be PEM-encoded.

Example:
tlsCA=/tmp/ca1_certificate.crt,/tmp/ca2_certificate.crt
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tlsVerifyServerCertificate

Optional with LDAPS only. This parameter is optional for LDAPS connections to the LDAP server. If
set to true or missing, the LDAP server certificate is verified against the list of trusted CA certificates
specified in tlsCA.
Default: true

mixedMode=true

Required.When set to true, both LDAP users and local users can log into BVD. When set to false,
only LDAP users are able to log in.
Default: true

autoCreateUser

Required.When set to true, BVD automatically creates a user for every LDAP user when the user
logs into BVD with correct credentials for the first time. When set to false, an LDAP user can only log
into BVD when createdmanually in BVD UserManagement.
Default: true

3. Run the BVD configuration tool using your modified configuration .ini file as input:

Windows: "<BVD_Install_Dir>\BVD\bin\configure.bat" -c <configuration_file>.ini

Linux: /opt/HP/BVD/bin/configure.sh -c <configuration_file>.ini

4. After the configuration tool completes, verify that the BVD processes are running, type:

ovc -status

How to Map Groups Configured in BVD to Groups Configured on the LDAP Server
1. LDAP must be configured in the BVD configuration .ini file as described in "How to Configure the

Connection to the LDAP Server" on page 51.

Make sure the groupSearchBase and groupSearchFilter parameters are configured.
2. Open User Management in BVD:

Administration > User Management
3. Click theManage Groups button and select the group you want to edit or create a new group.
4. In the properties section of the selected group, search for and assign LDAP groups in theMapped

LDAP groups field as required. When done, save the group.

Note: Although dynamic groups can be selected, they are not supported by BVD and therefore
ignored in groups search.

Download Tools and Samples
BVD provides an extensive set of tools and samples to help you develop dashboards and integrate data:

Visio Stencil (required)

BusinessValadmueDashboardStencil.zip. Contains the BVD widgets for Visio. Start Visio; in the
Shapeswindow, click More Shapes > Open Stencil and select the extracted BVD stencil file.
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You can also save the stencil file toC:\Users\<user name>\My Documents\My Shapes folder and then
access the BVD stencil in Visio inMore Shapes > My Shapes.

Visio Dashboard Template (useful)

Dashboard_Template.zip. Contains a Visio template with an embeddedmacro. Themacro exports your
Visio drawing to SVG each time you save it. The SVG file has the same name as the Visio drawing and is
stored in the same folder.

You can add the BVD template to Visio by specifying the template file name inVisio Options > Save >
Default personal templates location.

Visio Addin (useful)

VisioAddIn.zip. Contains an installer for a Visio ribbon calledDashboard. The buttonExport
Dashboard in the ribbon exports your Visio drawing to an SVG file with the same name and in the same
folder as the drawing itself.

Make sure you have administrative privileges when installing the Visio Addin.

Data Generator Sample (interesting)

samplegen.zip. Contains a VBScript and a batch file to send data to the OMi sample dashboard. The
batch file prompts you for the URL of your data receiver, your API key, and the HTTP proxy and port.

Sample OMi Status Dashboard (interesting)

omi_sample.zip. Contains the Visio drawing of the OMi sample dashboard. The dashboard is the target
of the data sent by the data generator VBScript. You can use it as the basis for creating your ownOMi
event and KPI status dashboards.

AO-Bank Sample Dashboards (useful)

ao-bank.zip. Contains the Visio files for the AO-Bank sample dashboards, which you can view at the
BVD demo.

AO-Cellular Sample Dashboards (useful)

ao-cellular.zip. Contains the Visio files for a sample cellular provider.

OMi 10.x Tools (required for the OMi integration)

bvd-omi-tools-10.x.zip. Contains the script/batch file and the BVD configuration file required for
integrating event, status, andmetrics data from OMi 10.x. The tools are included out-of-the-box with OMi
10.10 and later. See also "OMi Integration" on the next page.

OMi 09.x Tools (required for the OMi integration)

bvd-omi-tools-09.x.zip. Contains the script/batch file and the BVD configuration file required for
integrating event, status, andmetrics data from OMi 9.x. See also "OMi Integration" on the next page.
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Data Integration
BVD provides out-of-the-box integrations with HPE Software products such as HPE Operations Manager i
(OMi) and HPE Business ServiceManagement Connector (BSM Connector).

However, you can create your own integrations for any data source by writing an adapter for BVD. The
adapter must convert the source data to JSON and send the JSON-enabled data to the BVD data receiver.
Predefined dashboards that are designed and configured to display the data received then complement your
integration.

This section includes:

• OMi Integration 56
• Forward OMi Event Status 61
• Forward OMi KPI Status 64
• Forward OMi Metrics Data 67

• BSMConnector Integration 68
• Custom Integrations 71
• Example: Sending JSON Data to BVD 73

OMi Integration
You can configure OMi to send the following data to BVD:

Event status data: The event status to be forwarded is collected from anOMi monitoring dashboard that you
specify. Use the bvd-event-status command-line interface on theOMi server to forward event status. See
"Forward OMi Event Status" on page 61.

KPI status data: The KPI status is collected from all CIs that are associated with a view that you specify and
that have the KPI set that you specify. Use the bvd-kpi-status command-line interface on theOMi server to
forward KPI status. See "Forward OMi KPI Status" on page 64.

Metrics data: Themetrics data is collected from your graph favorites in OMi. To forwardmetrics data, enable
data forwarding in PerformanceGraphing (known as Performance Dashboard in OMi 10.10), then save your
graphs as favorites with the export (or forward) data option selected. See "Forward OMi Metrics Data" on
page 67.

This section includes:

l "Support matrix" on the next page
l "Install and configure the event and KPI status forwarding tools on the OMi server" on the next page
l "Configure and enablemetrics data forwarding on theOMi server" on page 58
l "Import the BVD certificate to the OMi server" on page 60
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Support matrix
For a list of supported OMi versions including required hotfixes, see the support matrix:

Support Matrices for Operations Center products

Download and extract the support matrix files, open the document SUMA.htm and select Operations
Manager i Business Value Dashboard from the product list.

Install and configure the event and KPI status forwarding tools on the OMi server
1. OMi versions earlier than 10.10 only. Download and install the BVD-OMi integration tools on the OMi

server. This step is only required for OMi versions earlier than 10.10. The tools are included out-of-the-
box with OMi 10.10 and later.

a. In BVD, download the data forwarding tools for your version of OMi: 10.0x or 9.2x. Go to
Administration > Download Tools & Samples and downloadOMi 10.x Tools orOMi 09.x
Tools.

b. In BVD, open Administration > System Settings, and copy theAPI Key.
This key identifies your BVD instance andmust be included in the data submitted by the data
senders.

Note: The System Settings page is only available to users with administrator privileges.

c. Copy the ZIP file to a temporary directory on the OMi gateway server, and extract it to the OMi
installation directory C:\HPBSM\ or /opt/HP/BSM/.
The following files are placed on your system:

opr/bin/bvd-event-status.bat
opr/bin/bvd-event-status.sh
opr/bin/bvd-kpi-status.bat
opr/bin/bvd-kpi-status.sh
opr/examples/bvd/bvdconf-sample.json
opr/lib/bvd/groovy-all.jar
opr/lib/bvd/bvd-omi-tools.jar

2. Create the subdirectory opr on theOMi server, copy the sample configuration file bvdconf-
sample.json to that directory, and rename it to bvdconf.json:
Windows: %OvDataDir%\shared\server\conf\opr\bvdconf.json
Linux: /var/opt/OV/shared/server/conf/opr/bvdconf.json

3. Edit the file bvdconf.json and fill in the following information in the OMiEventStatus and OMiKPIStatus
sections:
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url Required. URL of the BVD receiver including your API key, which identifies your
BVD instance.

Replace <BVD_URL>with the URL of your BVD receiver:
http(s)://<BVD_server>:<port>

<BVD_server> represents the Fully Qualified Domain Name (FQDN) of the
BVD server; <port> is the port assigned to the BVD receiver during the
configuration (default: 12224 or 12225).

Replace <YourApiKey>with your BVD API key from Administration > System
Settings.

dims Required. Comma-separated list of dims. Dims are the fields in the data you send
to BVD, for example, viewName, ciName, and kpiName.

tags Optional. Comma-separated list of tags. Tags enable you to createmore specific
data channels. For example, adding the tags omi,kpi creates the data channel
omi<>kpi<>viewName<>ciName<>kpiName.

proxyHost Optional. If your network includes a proxy, insert the FQDN of the proxy server (for
example, myproxy.example.com).

proxyPort Optional. Port of the proxy (for example, 8888).

proxyUser Optional. User account to access the proxy.

proxyPassword Optional. Password of the proxy user account.

Tip: Changing the default dims and tags also requires you to update the data channels that are
configured in the dashboards (for example, in the sample dashboard omi_sample).

Configure and enable metrics data forwarding on the OMi server
1. Prerequisite.Make sure the PerformanceGraphing hotfixes for your version of OMi are installed. For

details, see the support matrix:
Support Matrices for Operations Center products
Download and extract the support matrix files, open the document SUMA.htm and select Operations
Manager i Business Value Dashboard from the product list.

2. In BVD, open Administration > System Settings, and copy theAPI Key.
This key identifies your BVD instance andmust be included in the data submitted by the data senders.

Note: The System Settings page is only available to users with administrator privileges.

3. Edit the file bvdconf.json file on the OMi gateway server:
Windows: %OvDataDir%shared\server\conf\opr\bvdconf.json
Linux: /var/opt/OV/shared/server/conf/opr/bvdconf.json

Tip: If the file does not yet exist, download and extract the OMi data forwarding tools from BVD. For
details, see "Install and configure the event and KPI status forwarding tools on the OMi server" on
the previous page.
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4. Fill in the following information:

name Required. Replace <YourEndpointName>with the name of the endpoint to which
PerformanceGraphing forwards data, for example, ColorYourData. This namemust
match the endpoint name set in the PerformanceGraphing infrastructure setting
"Endpoint Name" below.

url Required. URL of the BVD receiver including your API key, which identifies your BVD
instance.

Replace <BVD_URL>with the URL of your BVD receiver:
http(s)://<BVD_server>:<port>

<BVD_server> represents the Fully Qualified Domain Name (FQDN) of the
BVD server; <port> is the port assigned to the BVD receiver during the configuration
(default: 12224 or 12225).

Replace <YourApiKey>with your BVD API key from Administration > System
Settings.

tags Optional. Comma-separated list of tags. Tags enable you to createmore specific data
channels. For example, the tags PerformanceGrapher,OMi create the data channel
PerformanceGrapher<>OMi<>metricName<>instanceName<>dSName<>systemName<
>className.

proxyHost Optional. If your network includes a proxy, insert the FQDN of the proxy server (for
example, myproxy.example.com).

proxyPort Optional. Port of the proxy (for example, 8888).

proxyUser Optional. User account to access the proxy.

proxyPasswo
rd

Optional. Password of the proxy user account.

5. In OMi, open Infrastructure Settings:
o OMi 9.2x and 10.0x: Admin > Platform > Setup and Maintenance -> Infrastructure Settings

In theApplications list, select Performance Graphing.

o OMi 10.10: Administration > Setup and Maintenance > Infrastructure Settings
In theApplications list, select Performance Dashboard.

Configure the following settings:

Endpoint Name Name of the endpoint to which the PerformanceGraphing data is forwarded. It
must match the endpoint name specified in the bvdconf.json file.

Turn on Data
forwarding to
Endpoint

Set this parameter to true to enable data forwarding from Performance
Graphing to the BVD endpoint.
Default: false
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Data Forward
Interval to
Endpoint

Configure the interval (in seconds) at which PerformanceGraphing forwards
the data to the endpoint.
Default: 15 seconds

Data Collection
interval for non-
real time
datasource

Configures the interval (in minutes) at which PerformanceGraphing collects
the data from non-real time data sources. The data collected is then forwarded
to the configured endpoint.
Default: 5 minutes

6. In the Performance Perspective, select themetrics that you want to forward and save them as favorites.
For details, see "Forward OMi Metrics Data" on page 67.

Note: If youmake any subsequent changes to the bvdconf.json file, youmust reset the Turn on Data
forwarding to Endpoint setting in the Infrastructure Settings. To reset, set Turn on Data forwarding
to Endpoint to false and then set it back to true.

Import the BVD certificate to the OMi server

Note: This step is mandatory for OMi 10.10, but applicable for OMi 9.2x and 10.0x only if SSL is enabled.

Secure the connection to BVD for metrics data forwarding by importing the BVD certificate to the OMi
gateway server.

1. Export the BVD certificate using a web browser, for example Firefox:
a. In the Firefox address bar, click the padlock icon, then click More Information. ThePage Info page

opens at theSecurity tab.
b. In theSecurity tab, click View Certificate.

Open theDetails tab and click Export. Choose the file name and folder where you want to save the
exported certificate and click Save. The export places the certificate file <file_name>.crt on your
system.

c. Make sure the downloaded certificate is available on the OMi gateway server.

Tip: You can also export the certificate from Internet Explorer if you first installed it in the browser:
Internet Options > Content > Certificates > Export.

2. On theOMi gateway server, import the certificate to the local Java certificate store:
o OMi 9.2x and 10.0x:

<OMi_HOME>/JRE[64]/bin/keytool -import -trustcacerts -keystore <path_to_keystore>
-storepass <password> -alias <alias> -file <path_to_certificate>

Example:
%TOPAZ_HOME%\JRE64\bin\keytool.exe -import -trustcacerts -keystore %TOPAZ_
HOME%/JRE64/lib/security/cacerts -storepass changeit -alias myRootCA -file
c:\temp\BVDcert.crt

o OMi 10.10:

<OMi_HOME>/bin/opr-cert-mgmt.[bat|sh] -import <alias> <path_to_certificate>
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Example:
%TOPAZ_HOME%\bin\opr-cert-mgmt.bat -import -alias myRootCA c:\temp\BVDcert.crt

3. Verify that the certificate was successfully added to the keystore:
o OMi 9.2x and 10.0x:

<OMi_HOME>/JRE[64]/bin/keytool -list -keystore <path_to_keystore>

Example:
%TOPAZ_HOME%\JRE64\bin\keytool.exe -list -keystore %TOPAZ_
HOME%/JRE64/lib/security/cacerts

o OMi 10.10:

<OMi_HOME>/bin/opr-cert-mgmt.[bat|sh] -list

Example:
%TOPAZ_HOME%\bin\opr-cert-mgmt.bat -list

Forward OMi Event Status
Use the bvd-event-status command-line interface to forward event status data from OMi to BVD.

BVD data channels opened up by the bvd-event-status command-line interface:

omi<>mdb<>dashboard_name<>label<>type

Before you can use the tool, install it as described in "Install and configure the event and KPI status
forwarding tools on the OMi server" on page 57.

Location
<OMi_HOME>/opr/bin/bvd-event-status.[bat|sh]

Synopsis
bvd-event-status <connection> -dashboard_name <Dashboard Name> [-polling_interval
<Polling Interval>] [-dashboard_config <BVD Config File>] -help | -verbose | -version

Options

Option Description

{-dashboard_
name|-dn}
<Dashboard Name>

Sets the name of the dashboard for which event status data will be collected.
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Option Description

{-polling_
interval|-pi}
<Polling Interval>

Sets the polling interval (in milliseconds) for collecting event status data.

Default: 10,000milliseconds (10 seconds)

{-dashboard_
config|-dc} <BVD
Config File>

Sets the path to the BVD configuration file bvdconf.json. If omitted, it assumes
the file in the following directory:

Windows: %OvDataDir%\shared\server\conf\opr\bvdconf.json

Linux: /var/opt/OV/shared/server/conf/opr/bvdconf.json

{-post2|-p2} For internal use only.

{-help|-h} Displays a summary of the command options.

{-verbose|-v} Prints verbose output.

-version Displays version information for the tool.

Syntax for <connection>
-username <login name> [ -password <password> | -smartcard | -winCrypto | -jks <keystore
path> -jksPassword <keystore password> ] [[-port <port>] [-server <gatewayserver>] [-
ssl]] [-customer <customer ID>]

Note: If you do not specify the OMi server to connect to (using the -server option), the command is
executed on the server to which you are logged on.

Option Description

{-username|-user}
<login name>

Sets the login name of the user required to execute CLI operations on the
target gateway server.

{-password|-pw}
<password>

Sets the password for the specified user. If using SSH onCygwin, either
enter the password in free text or use other communicationmethods, for
example Java keystore, Windows keystore, or smart card authentication.

Default value: empty string

{-smartcard|-sc} Uses the certificate stored on smart card or security token for
authentication.

{-winCrypto|-wc} If OMi is configured for TLS mutual authentication, this option specifies to
use theWindows certificate store for authentication. The certificate store
must hold exactly one client certificate, which OMi will use to authenticate
the user. This option is only available onWindows systems.
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Option Description

{-jks|-j} <keystore
path>

If OMi is configured for TLS mutual authentication, this option can be used to
specify the Java keystore to be used for authentication. The keystoremust
hold exactly one client certificate, which OMi will use to authenticate the
user.

Note: It is not necessary that the client certificate contains the flag
"Smart Card Logon (1.3.6.1.4.1.311.20.2.2)" in the "Enhanced Key
Usage" field.

{-jksPassword|-jp}
<keystore password>

If OMi is configured for TLS mutual authentication, this option can be used to
specify the Java keystore to be used for authentication. The keystoremust
hold exactly one client certificate, which OMi will use to authenticate the
user.

Note: It is not necessary that the client certificate contains the flag
"Smart Card Logon (1.3.6.1.4.1.311.20.2.2)" in the "Enhanced Key
Usage" field.

{-port|-p} <port> Uses port <port> to connect to the target gateway server.

Default value of <port>:
80 for HTTP connections
443 for HTTPS connections

-server
<GatewayServer>

Sets the target gateway server, using <GatewayServer> as the hostname or
IP address to locate it.

Default value of <GatewayServer>:
FQDN of the OMi gateway server

-ssl When this option is specified, the HTTPS protocol is used to connect to the
target gateway server. If omitted, the HTTP protocol is used.

{-customer|-cu}
<customer ID>

Sets the identification number associated with a particular customer.

Default value: 1

Exit Status

Exit
Status Description Output

0 Successful completion of the
requested operation

No output.

1 Failure of the requested
operation

An error message stating why the operation failed, followed by
the tool's help text.
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Exit
Status Description Output

300-399 HTTP Redirection (300-399) An error message stating the HTTP error number and
description.

For more information about HTTP error status values, see
publicly available HTTP documentation.

400-499 HTTP Client Error (400-499)

500-599 HTTP Internal Server Error
(500-599)

Examples
The following example forwards event status from theOMi monitoring dashboard OMi Health Status to
BVD:

\HPBSM\opr\bin\bvd-event-status.bat -username admin -dashboard_name "OMi Health Status"

Forward OMi KPI Status
Use the bvd-kpi-status command-line interface to forward KPI status data from OMi to BVD.

Before you can use the tool, install it as described in "Install and configure the event and KPI status
forwarding tools on the OMi server" on page 57.

BVD data channels opened up by the bvd-kpi-status command-line interface:

omi<>kpi<>viewName<>ciName<>kpiName

Location
<OMi_HOME>/opr/bin/bvd-kpi-status.[bat|sh]

Synopsis
bvd-kpi-status <connection> -view_name <View Name> [-kpi_name <KPI Name>] [-polling_
interval <Polling Interval>] [-dashboard_config <BVD Config File>] -help | -verbose | -
version

Options

Option Description

{-view_name|-vn}
<View Name>

Sets the name of the view for which KPI status data will be collected.

{-kpi_name|-kn}
<KPI Name>

Sets the name of the KPI for which status data will be collected. If omitted, bvd-
kpi-status sends the status of all KPIs for all CIs that are related to the given
view name.
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Option Description

{-polling_
interval|-pi}
<Polling Interval>

Sets the polling interval (in milliseconds) for collecting event status data.

Default: 10,000milliseconds (10 seconds)

{-dashboard_
config|-dc} <BVD
Config File>

Sets the path to the BVD configuration file bvdconf.json. If omitted, it assumes
the file in the following directory:

Windows: %OvDataDir%\shared\server\conf\opr\bvdconf.json

Linux: /var/opt/OV/shared/server/conf/opr/bvdconf.json

{-post2|-p2} For internal use only.

{-help|-h} Displays a summary of the command options.

{-verbose|-v} Prints verbose output.

-version Displays version information for the tool.

Syntax for <connection>
-username <login name> [ -password <password> | -smartcard | -winCrypto | -jks <keystore
path> -jksPassword <keystore password> ] [[-port <port>] [-server <gatewayserver>] [-
ssl]] [-customer <customer ID>]

Note: If you do not specify the OMi server to connect to (using the -server option), the command is
executed on the server to which you are logged on.

Option Description

{-username|-user}
<login name>

Sets the login name of the user required to execute CLI operations on the
target gateway server.

{-password|-pw}
<password>

Sets the password for the specified user. If using SSH onCygwin, either
enter the password in free text or use other communicationmethods, for
example Java keystore, Windows keystore, or smart card authentication.

Default value: empty string

{-smartcard|-sc} Uses the certificate stored on smart card or security token for
authentication.

{-winCrypto|-wc} If OMi is configured for TLS mutual authentication, this option specifies to
use theWindows certificate store for authentication. The certificate store
must hold exactly one client certificate, which OMi will use to authenticate
the user. This option is only available onWindows systems.
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Option Description

{-jks|-j} <keystore
path>

If OMi is configured for TLS mutual authentication, this option can be used to
specify the Java keystore to be used for authentication. The keystoremust
hold exactly one client certificate, which OMi will use to authenticate the
user.

Note: It is not necessary that the client certificate contains the flag
"Smart Card Logon (1.3.6.1.4.1.311.20.2.2)" in the "Enhanced Key
Usage" field.

{-jksPassword|-jp}
<keystore password>

If OMi is configured for TLS mutual authentication, this option can be used to
specify the Java keystore to be used for authentication. The keystoremust
hold exactly one client certificate, which OMi will use to authenticate the
user.

Note: It is not necessary that the client certificate contains the flag
"Smart Card Logon (1.3.6.1.4.1.311.20.2.2)" in the "Enhanced Key
Usage" field.

{-port|-p} <port> Uses port <port> to connect to the target gateway server.

Default value of <port>:
80 for HTTP connections
443 for HTTPS connections

-server
<GatewayServer>

Sets the target gateway server, using <GatewayServer> as the hostname or
IP address to locate it.

Default value of <GatewayServer>:
FQDN of the OMi gateway server

-ssl When this option is specified, the HTTPS protocol is used to connect to the
target gateway server. If omitted, the HTTP protocol is used.

{-customer|-cu}
<customer ID>

Sets the identification number associated with a particular customer.

Default value: 1

Exit Status

Exit
Status Description Output

0 Successful completion of the
requested operation

No output.

1 Failure of the requested
operation

An error message stating why the operation failed, followed by
the tool's help text.
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Exit
Status Description Output

300-399 HTTP Redirection (300-399) An error message stating the HTTP error number and
description.

For more information about HTTP error status values, see
publicly available HTTP documentation.

400-499 HTTP Client Error (400-499)

500-599 HTTP Internal Server Error
(500-599)

Examples
The following example forwards KPI status to BVD for all CIs in the view OprSample that have the KPI
Unassigned Events assigned:

\HPBSM\opr\bin\bvd-kpi-status.bat -username admin -view_name OprSample -kpi_name
"Unassigned Events"

Forward OMi Metrics Data
You can configure PerformanceGraphing (known as Performance Dashboard in OMi 10.10 ) to forward
metrics data from OMi to BVD. Themetrics data is collected from your graph favorites in OMi. Your favorites
must be configured to export or forward data to BVD.

Before PerformanceGraphing starts forwarding data, configure and enable data forwarding to BVD as
described in "Configure and enablemetrics data forwarding on theOMi server" on page 58.

BVD data channels opened up by PerformanceGraphing:

metricName<>instanceName<>dSName<>systemName<>className

Saving charts as favorites for data forwarding
1. In OMi, open thePerformance Perspective:

OMi 9.2x: Applications > Operations Management > Performance Perspective
OMi 10.x:Workspaces > Operations Console > Performance Perspective

2. From theView Explorer, select a view and then the CI for which you want to draw graphs (or
dashboards). Then save the graphs as favorites with the "export to BVD" option selected as described
below:
o OMi 9.2x and 10.0x:

From theMetrics tab on thePerformance pane, select the data source, themetrics class, the
instance, and themetrics you want to forward. Drag themetrics that you want to see in BVD to the
Drawn Graphs pane.

Click Save as Favorite. In theSave as Favorite dialog box, select Export Data, then click
Save.

o OMi 10.10:
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In the Performance pane, click Dashboard Selection and then click the dashboard to view the
dashboard. Click the title of the chart and then click Add to Favorite. In the Favorites dialog box,
you can add the favorite to the default page, user-defined favorite page, or create a new user-defined
favorite page. Then click Save.

Launch the favorite, click the Enable/Disable data forward to BVD button, and then click Save
to save your changes to the favorite.

PerformanceGraphing forwards metrics for all graphs that are saved as favorites and that are configured to
export or forward data to BVD.

BSM Connector Integration
To forward performance data from BSMConnector to BVD, create a Data Forwarding policy in BSM
Connector. The policy must specify your BVD instance as a target and contains rules that specify which data
is sent to BVD.

Learn More

Support matrix
For a list of supported BSMConnector versions, see the support matrix:

Support Matrices for Operations Center products

Download and extract the support matrix files, open the document SUMA.htm and select Operations
Manager i Business Value Dashboard from the product list.

Tasks
This section includes:

l "Configuring data forwarding in BSM Connector" below
l "Forwarding data using an HTTP proxy" on page 70
l "Forwarding data using HTTPS" on page 70

Configuring data forwarding in BSM Connector

1. In BVD, open Administration > System Settings, and copy theAPI Key.
This key identifies your BVD instance andmust be included in the data submitted by the data senders.

Note: The System Settings page is only available to users with administrator privileges.

2. In BSM Connector, click Create in the toolbar. Then click Forwarding > Data Forwarding.
3. In theProperties page, define information that is related to the policy itself (for example, the name and

description of the policy).
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4. In the Targets page, set up your BVD instance as a target to which the data is forwarded:

a. In the target list, click New Item above theName column to add a new target.
b. Enter the name of the BVD target and a description.
c. Enter the URL of your BVD data receiver. The URLmust include your API key and dimensions or

tags (or both dimensions and tags) to create unique data channels for your metrics data:
BVD expects to receive your data as HTTP post requests in JavaScript Object Notation (JSON)
format.
The URL should look something like this:

http(s)://<BVD_server>:<port>/api/submit/<API_key>/dims/<dims>

<BVD_server>

The Fully Qualified Domain Name (FQDN) of the BVD server.

<port>

The port assigned to the BVD receiver during the configuration (default: 12224 or 12225).

<API_key>

Identifies your BVD instance. You can find the API key in Administration > System
Settings.

<dims>

The names in your JSON name-value pairs. Select and combine dims that uniquely identify your
data.

For more information on the URL of the BVD data receiver, see "Sending dims and tags to the
receiver URL" on page 71.

Example:
You can add the followingmetrics attributes as dimensions to the URL:

dims/dataDomain,relatedCi,name,metricClass,node

This results in the following data channel:

HPBsmIntOEM<>oem.example.com/oracle_database/oemdb<>Average Active
Sessions<>Throughput<>oem.example.com

For information on themetrics attributes, see the BSMConnector documentation.
d. Select JSON asWire format.
e. Make sureUse Guaranteed Delivery is cleared. If you select this check box, BSM Connector

attempts to resend data that could not be delivered earlier and BVD may receive outdated data.
5. Configure data forwarding rules:

o To forwardmetrics data after policy rules are applied, select theMetric page and configuremetric
data forwarding rules.
Metric forwarding rules define what a Data Forwarding policy should do in response to specific metric
data. Each rule consists of a condition and of settings for the data generated by the policy. The
settings enable you to configure what data BSM Connector forwards to which target.

o To forward structured input data, that is, data gathered by a policy before the policy rules are applied,
select theStructured Input page and configure structured input data forwarding rules.
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Structured input data rules define what a Data Forwarding policy should do in response to specific
structured input data. Each rule consists of a condition and of settings for the data generated by the
policy. The settings enable you to configure what data BSM Connector forwards to which target.

Discarding rules have a higher precedence than forwarding rules.
6. Click Save and Close to save the policy and close the editor.
7. Activate the Data Forwarding policy in BSM Connector. BSM Connector starts sending data to BVD.

In BVD, connect your widgets to the data channels opened up by BSMConnector.

Forwarding data using an HTTP proxy
If you need to redirect the connection from BSMConnector to BVD through an HTTP proxy, configure the
BSMConnector system as follows:

1. Edit the XPL configuration file:

ovconfchg -edit

2. Add the following lines:

[bbc.http]
PROXY=<proxy_hostname>:<proxy_port>+(<included hosts>)-(<excluded hosts>)

Replace <included_hosts>with a comma-separated list of hostnames or IP addresses to which the
proxy enables communication. Replace <excluded hosts>with a comma-separated list of hostnames
or IP addresses to which the proxy cannot connect. Asterisks (*) are wild cards in hostnames and IP
addresses. Both <included_hosts> and <excluded hosts> are optional.
To specify multiple proxies, separate each proxy with a semicolon (;). The first suitable proxy in the list
takes precedence.

Example:

[bbc.http]
PROXY=myproxy.example.com:8888+(mybvd.example.com)

3. Restart the BSM Connector process that forwards the data:

ovc -restart opcgeni

Forwarding data using HTTPS
By default, BSM Connector only trusts the OMi server as certificate authority (CA). For BSM Connector to
trust the CA that issued the BVD certificate, youmust download the root CA certificates from the BVD CA
and import them to BSMConnector trusted root certificate store.

1. Obtain the root CA certificates from the root and any intermediate authorities that issued the BVD server
certificate.

2. On the BSMConnector system, import the certificates to the trusted root certificate store:

ovcert –importtrusted –file <certificate_file>

3. Optional. On the BSMConnector system, run the following command to verify that the trust has been
established:

bbcutil -ping https://<BVD_server>:<port>
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Example:
bbcutil -ping https://bvdserver.example.com:12225

The following output indicates that the HTTPS connection is successful.

https://<BVD_server>:<port>:
(bbc-288) status=eServiceError coreID= bbcV= appN= appV= conn=0 time=471 ms

eServiceError is normal and indicates that there is no BBC service on the BVD system. If the output
includes eSSLError (or similar), the HTTPS connection was not successful, possibly because the trust
has not been established correctly.

Custom Integrations
BVD expects to receive your data as HTTP post requests in JavaScript Object Notation (JSON) format.

It is recommended that your JSON input contains flat data, consisting of name-value pairs. If you need to
send nested data, BVD automatically flattens the data (see also "Nested JSON data" on the next page). You
can also send JSON data in arrays. This enables you to sendmultiple data objects in a single web service
call (see also "JSON data arrays" on the next page).

See also "Example: Sending JSON Data to BVD" on page 73.

Learn More
This section includes:

l "Sending dims and tags to the receiver URL" below
l "Sending dims and tags as HTTP parameters" on the next page
l "JSON data arrays" on the next page
l "Nested JSON data" on the next page
l "Data storage" on page 73

Sending dims and tags to the receiver URL
The BVD receiver URL should look something like this:

l URLwith dimensions only:

http(s)://<BVD_server>:<port>/api/submit/<API key>/dims/<dims>

l URLwith tags only:

http(s)://<BVD_server>:<port>/api/submit/<API key>/tags/<tags>

l URLwith both dimensions and tags:

http(s)://<BVD_server>:<port>/api/submit/<API key>/dims/<dims>/tags/<tags>

<BVD_server>

The Fully Qualified Domain Name (FQDN) of the BVD server.

<port>
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The port assigned to the BVD receiver during the configuration (default: 12224 or 12225).

<API_key>

Identifies your BVD instance. You can find the API key in Administration > System Settings.

<dims>

The names in your JSON name-value pairs. Select and combine dims that uniquely identify your data.

Sending dims and tags as HTTP parameters
You can also submit the dims and tags as HTTP parameters of the URL.

Example:

http://bvd.example.com:12224/api/submit/47a648e9065d465012e541288b5a345e?dims=viewNam
e,ciName,kpiName&tags=omi,kpi

JSON data arrays
You can submit multiple JSON objects in a single web service call by adding them to an array.

Array:

[
{

a: 1,
b: 2

},
{

c: 3,
 d: 4

}
]

Nested JSON data
If the input contains nested data, BVD automatically flattens the data by renaming nested name-value pairs
to include the names of the parent elements, separated by slashes (/), for example:

Nested JSON data: Flattened JSON data:

{
   a: 1,
   b: 2,
   c: {
      x: 6,
      y: 7
   }
}

{
   a: 1,
   b: 2,
   c/x: 6,

c/y: 7
}
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Data storage
BVD stores only the last 500 data records per channel. The records are only kept if they are related to a
widget. The BVD data aging process scans the database every hour to identify and automatically delete
records that exceed themaximum and are older than 100 days. You canmodify the aging defaults; for details,
see "Data Aging" on page 97.

Example: Sending JSON Data to BVD

Sending Data From Data Center East

In this example, Data Center East sends two sets of JSON data to the BVD server. In both sets, the data
fields host and metricName uniquely identify the value. The fields are therefore selected as dimensions
(dims) and included in the URL. Once received by the BVD server, the JSON data creates two data
channels: Host A <> CPU load and Host B <> Disk util.

Lessons learned:Pick the fields in your data that uniquely identify the values you want to send to
BVD and include the fields as dimensions in the HTTP post request.
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Sending Data From Data Center West

A second data center, Data CenterWest starts sending similar JSON data as Data Center East. The data
from Data CenterWest uses the same data channels as the data from East. To distinguish the data from
the two centers, you need to add the origin to the data. You can do this by adding tags to the URL. Tags are
static labels that you can attach to your data to createmore specific data channels.

In this example, we added the tags east and west to the URL. The tags precede the dims in the data
channels.

Lessons learned:Attach tags to your data to create specific data channels.
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Associating Data Channels with Widgets

Once BVD has received the data, it creates the corresponding data channels. You can then associate a
data channel with your widget in the widget's properties. In this example, the data channel east <> Host
A <> CPU load has been selected for the sparkline widget.

By default, the widget consumes data from the value data field. In this example, the current value is 42. If
the field that holds the values you are interested in has a different name (for example, metricVal), select
that name in the Data Field property of the widget.

Lessons learned:Connect your data to a widget by selecting the corresponding data channel in
the widget's properties.
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Knowledge Base
This section provides more advanced details about configuring BVD. It includes reference information,
procedures, and tips that youmay find useful.

Read this section when you are comfortable with the basic configuration steps, and refer back to it when
necessary. The information in this section is organized as a reference.

• Widgets 77
• Area andMultiple Area Chart Widgets 78
• Bar Chart Widgets 79
• Donut Chart Widgets 80
• FeedWidgets 81
• FrameWidgets 81
• Line Chart and SparklineWidgets 82
• Status Color Group 83
• Status ImageWidgets 83
• Status Visible Group 85
• Text ValueWidgets 85
• WebPageWidgets 85

• Widget Properties 86
• Chart Autoscale 86
• Chart Colors 87
• Chart Period 88
• Coloring Rule 88
• Data Channel 89
• Data Field 90
• Default Value 91
• Donut Size 91
• Donut Hole Size 91
• FeedMax Items 91
• Hyperlink 91
• Image Selection Rule 92
• Max Value 92
• Min Value 93
• MouseOver 94
• Number Format 94
• Reverse Order of Data Fields 94
• Show Chart Numbers 95
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• Start Angle 95
• Status Field 95
• Transparent Background 96
• URL 96
• Visibility Rule 96

• Data Aging 97
• Tips and Tricks 98
• Troubleshooting 104

Widgets
The topics in this section describe all available dashboard widgets. You can create the widgets from the
following BVD shapes in Visio:

You can edit the properties of a widget in Visio (by editing the Shape Data) or in BVD (by editing a dashboard
in Manage Dashboards). We recommend that youmake your changes in BVD because the dashboard editor
simplifies this task by offering values in drop-down lists for you to choose.

Some advanced operations can only be done in Visio itself. See "Tips and Tricks" on page 98 for details.

You can upload an SVG file as often as you want. If the file already exists, BVD replaces the previous version
of the file with the newer version and opens the associated dashboard for you to edit. The newer version does
not overwrite existing dashboard properties or widgets, only new widgets are added.

Rule Operators
Rules use operators to compare current and given values. The available operators are:

== equal

< less than

> greater than

<= less than or equal

>= greater than or equal
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!= not equal

Available widgets:

• Area andMultiple Area Chart Widgets 78
• Bar Chart Widgets 79
• Donut Chart Widgets 80
• FeedWidgets 81
• FrameWidgets 81
• Line Chart and SparklineWidgets 82
• Status Color Group 83
• Status ImageWidgets 83
• Status Visible Group 85
• Text ValueWidgets 85
• WebPageWidgets 85

Area and Multiple Area Chart Widgets
Area charts are used to display quantitative data. They are based on line charts.

If you have only one set of data to display, use a simpleArea Chartwidget:

To display multiple sets of data, use aMultiple Area Chartwidget:

You can customize the x- and y-axes by changing the font and color in Visio.

See also:

l "Data Channel" on page 89
l "Data Field" on page 90
l "Max Value" on page 92
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l "Min Value" on page 93
l "Chart Autoscale" on page 86
l "MouseOver" on page 94
l "Show Chart Numbers" on page 95
l "Chart Colors" on page 87
l "Chart Period" on page 88
l "Number Format" on page 94
l "Visibility Rule" on page 96
l "Hyperlink" on page 91

Bar Chart Widgets
Use theBar Chartwidget to display a bar chart. Bar charts are useful when you want to comparemultiple
values from the same data channel. Each bar in a bar chart corresponds to a field in the data received over the
associated data channel.

TheData Field and theChart Colors properties refer to the bars using a numbering scheme. Bar number 1 is
the leftmost bar with numbering continuing to the right:

For details on how to set the colors of the individual bars, see "Chart Colors" on page 87.

See also:

l "Data Channel" on page 89
l "Data Field" on page 90
l "Max Value" on page 92
l "Chart Autoscale" on page 86
l "Show Chart Numbers" on page 95
l "Chart Colors" on page 87
l "Number Format" on page 94
l "Visibility Rule" on page 96
l "Hyperlink" on page 91
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Donut Chart Widgets
Use theDonut Chartwidget to display a donut chart. Each slice in a donut chart corresponds to a field in the
data received over the associated data channel.

TheData Field and theChart Colors properties refer to the donut slices using a numbering scheme. Slice
number 1 is the top right slice with numbering continuing clockwise:

TheStart Angle andDonut Size properties determine the orientation and size of the donut. A default donut
chart has a start angle of 0 (zero) and a size of 360 degrees. To create a partial donut, set the start angle to
the angle at which you want the first slice to appear and specify the size of the donut, also in degrees.

For example, to create the following gauge-like semicircle donut, set the start angle to 270 and the donut size
to 180. The first slice starts at 270 degrees with the data sources organized clockwise.

See also:

l "Data Channel" on page 89
l "Data Field" on page 90
l "Start Angle" on page 95
l "Donut Size" on page 91
l "Donut Hole Size" on page 91
l "Max Value" on page 92
l "Reverse Order of Data Fields" on page 94
l "Show Chart Numbers" on page 95
l "Chart Colors" on page 87
l "Number Format" on page 94
l "Visibility Rule" on page 96
l "Hyperlink" on page 91
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Feed Widgets
The Feedwidget enables you to display information feeds, similar to well-knownRSS feeds. Feeds must be
sent as JSON-encoded data. The data channel must include the fields title and link in order to display the
feed. New feed items are always added to the top of the list.

The Feed widget displays the following items:

l The creation time stamp of the item.
l The title field as text (retrieved from the title data field).
l The link field as hyperlink (retrieved from the link data field).

Example feed data:

{
   "time":1437633749317,
   "type":"test",
   "title":"Tests show UK Quran manuscript is among world's oldest",
   "link":"http://rss.cnn.com/~r/rss/cnn_latest/~3/HgufPus_pOs/index.html"
}

Note: Do not rotate Feed widgets. This breaks the widget functionality.

You can style the displayed feed items by providing a custom CSS definition in the BVD System Settings.
For more information, see "System Settings" on page 38.

Example:

.feedItem .ts {display: none;}

.feedItem .even {background-color: #262627;}

.feedItem a:hover {text-decoration: none;}

.feedItem section {hight:30px; padding: 3px; margin: 0}

See also:

l "Data Channel" on page 89
l "FeedMax Items" on page 91
l "Transparent Background" on page 96

Frame Widgets
BVD offers the following Frame shapes:

l Frame 3:2
l Frame 4:3
l Frame 16:9
The shapes do not have any shape data defined. Their purpose is to help you lay out your dashboards based
on predefined ratios.
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Line Chart and Sparkline Widgets
Use the Line Chartwidget to show a line chart with axes and coordinates:

TheSparklinewidget creates a sparkline chart. Typically, a sparkline is a very small chart, shownwithout
axes or coordinates:

Tip: Position sparklines next to an absolute number to provide you with a quick reference to the data
trend.

You can change the style of the line in Visio.

See also:

l "Data Channel" on page 89
l "Data Field" on page 90
l "Max Value" on page 92
l "Min Value" on page 93
l "Chart Autoscale" on page 86
l "MouseOver" on page 94
l "Chart Period" on page 88
l "Number Format" on page 94
l "Visibility Rule" on page 96
l "Hyperlink" on page 91
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Status Color Group
Group theStatus Color Group shape with other shapes in Visio to make them change color depending on
the values received. You can define the values that cause a color change using the Coloring Rule property.

Use the group widget when you want to change the color of non-BVD shapes or to color a large number of
shapes. Then it is easier to group the shapes with the Status Color Group and set the coloring rule in the
group widget.

The Status Color Group widget can color the following SVG elements: <path>, <rect>, <ellipse>,
<circle>, and <polygon>.

See also:

l "Data Channel" on page 89
l "Coloring Rule" on page 88
l "Visibility Rule" on page 96
l "Hyperlink" on page 91

Status Image Widgets
Use the Status Image widget to display an image depending on the value received for the Status Field or
depending on a rule.

The Status Image shape is a group of shapes. Each shape in the group is an image,
and each image has the shape data Switch Value defined. For example, the "error"
image in the BVD Status Image shape has the Switch Value "red". BVD then
selects the image to display depending on the values received in the data channel.
You can choose the data field to use as input by selecting it in the Status Field
(default: status), or you can define an image selection rule. For example, if the
result of the image selection rule is "red", the "error" image is displayed.
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You can take a look at the Status Image shape in Visio by right-clicking the shape and selectingGroup >
Open Status Image.

Caution: Never ungroup the Status Image shape.

The shape consists of the following four images:

Image Name Switch Value Image

ok green

warning yellow

error red

unknown grey

Do it yourself - Create your own Status Image
1. Make sure Visio is running in developer mode:

File > Options > Advanced > Run in developer mode
2. Drag the BVD Status Image shape to your drawing.
3. Right-click the Status Image shape and select Group > Open Status Image.

You are now inside the shape. You can start editing, deleting, or adding shapes as required.
4. If you add a new shape, youmust add the shape dataSwitch Value to the shape:

a. Right-click the added shape and select Data > Define Shape Data.
b. Add a property with the name opr_switch_value of the type String.
c. Set the value of the property to a value of the Status Field or one that can be selected by an Image

Selection Rule.
After uploading the exported SVG file to BVD, select the data channel for your Status Image widget. Then
either select a data field for the Status Field property or configure an image selection rule. You also need to
set a default value for situations when no value is available or the value is not one of the defined switch
values.

See also:

l "Data Channel" on page 89
l "Status Field" on page 95
l "Default Value" on page 91
l "Image Selection Rule" on page 92
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l "Visibility Rule" on page 96
l "Hyperlink" on page 91

Status Visible Group
Group the invisibleStatus Visible Group Visio shape with other shapes to show or hide the widgets
depending on the result of the rule defined in theVisibility Rule property.

Tip: Use the group widget when you want to show or hide non-BVD shapes, or to show or hide a large
number of shapes. Then it is easier to group the shapes with the Status Visible Group and set the
visibility rule in the group widget. You can also set the visibility of a widget based on its Visibility Rule
property. Use this property to show or hide individual widgets.

See also:

l "Data Channel" on page 89
l "Visibility Rule" on page 96
l "Hyperlink" on page 91

Text Value Widgets
Use the Text Value widget to display values or to color text. Text attributes like font, alignment, and rotation
are not updated.

For example, you could use the text value widget to display the current temperature in your store in New York
City. As temperaturemeasurements arrive, the number changes reflecting the current temperaturemeasured
in the store. Additionally, you could configure the text value widget to change the color of the value displayed
depending on the current temperature:

See also:

l "Data Channel" on page 89
l "Data Field" on page 90
l "Number Format" on page 94
l "Coloring Rule" on page 88
l "Visibility Rule" on page 96
l "Hyperlink" on page 91

Web Page Widgets
Web Pagewidgets enable you to show web pages in a dashboard. For example, you can include web pages
that stream television, video, or audio.

Installation and Administration Guide
Knowledge Base

HPE OMi Business Value Dashboard (10.10) Page 85 of 109



The website must be accessible via HTTPS because the BVD UI is also only accessible via HTTPS.
However, if the website sends an X-Frame-Options HTTP header restricting the embedding of this page to
same origin, the browser will not display this web page within the dashboard.

Note: Do not rotateWeb Page widgets. This breaks the widget functionality.

See also:

l "URL" on page 96

Widget Properties
The topics in this section describe all available widget properties.

• Chart Autoscale 86
• Chart Colors 87
• Chart Period 88
• Coloring Rule 88
• Data Channel 89
• Data Field 90
• Default Value 91
• Donut Size 91
• Donut Hole Size 91
• FeedMax Items 91
• Hyperlink 91
• Image Selection Rule 92
• Max Value 92
• Min Value 93
• MouseOver 94
• Number Format 94
• Reverse Order of Data Fields 94
• Show Chart Numbers 95
• Start Angle 95
• Status Field 95
• Transparent Background 96
• URL 96
• Visibility Rule 96

Chart Autoscale
Chart Autoscale automatically scales themaximum values and, if available, minimum values.
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Bar charts only. If you set Max Value to 0, the bar with the highest value will be shown in full height; the
height of all other bars is shown relative to the highest bar.

Default: not selected

Examples:

The following three sparklines have the same size and show the same data. The scaling, however,
differs because of different min andmax values or Autoscale:

Chart Colors
TheChart Colors property enables you to set colors for your charts. Provide a semicolon-separated list of
RGB color codes in hexadecimal notation.

You can choose the coloring of the first four colors by changing the colors in Visio. However, the colors you
specify in the Chart Colors property override the colors defined in Visio.

If you specify only one color, BVD uses this color for the first data field, and uses the Visio-defined colors for
data fields two to four. If more than four data fields but no colors are defined, BVD randomly chooses a color
for data fields five and higher.

Default: not defined

Example Donut Chart:

The donut chart in the OMi sample dashboard uses the following color codes:

FF0000;FF9933;C8C800;33CC33;B2B2B2

They color the donut chart like this:
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Chart Period
Use theChart Period property to set the period of time (in minutes) for which the widget will display data.

BVD stores only the last 500 data records received from the data senders. To be able to display data, you
need to align the chart period with the rate data is received. For example, if BVD receives one value per day,
themaximum chart period would be 720,000minutes (500 days). If data is received every 15minutes, the
maximum chart period would be 7,500minutes (5.2 days).

Default: 10minutes

Examples:

The following two sparklines have the same size and show the same data. The upper line shows the data
for the last 10minutes, the lower line only the last minute.

Coloring Rule
TheColoring Rule property enables you to determine the color to display depending on the outcome of a
rule.
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You can addmultiple coloring rules separated by semicolons:

Rule format: <rule>;<rule>;...

Coloring rules can contain a value only; for example, the value #008000 in a coloring rule colors the widget
green. Rules can also contain conditions that must bematched; for example, #008000:temperature<60
colors a widget green when the value of the data field temperature is less than 60.

Rules are evaluated from left to right. When one condition is matched, no additional rules will be evaluated. If
no rule matches, the default is applied; therefore, when you define a set of rules, always insert the default as
the last rule.

Coloring rules have the following format:

<color>[:<property><operator><value>]

<color>
RGB color code; for example, #000000.

<property>
The name of the data property to use to calculate the color.

<operator>
The operation that is used to compare the current value of the property with the given value. For a list of
operators, see "Rule Operators" on page 77.

<value>
The value the operator works on.

Example:

#AABBCC:temperature<60;#7FFF00:temperature<30;#00ff00

If the value of the data field temperature is less than 60, the color #AABBCC is used. If the value is less
than 30, the color #7FFF00 is used. In all other cases, #00ff00 is used as the color.

Data Channel
TheData Channel property enables you to select the data stream over which you want to feed data into the
widget. Before you can select a data stream, youmust send data to BVD, addressed to the data channel you
want to select for your widget.

Example:

To show the rise and fall of the temperature in your store in New York City, select the following data
channel for your widget:

The data received includes the following:

type: Temperature
element: Monitor
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value: 20.9
status: #008000

Data Field
Select one or more data fields in the data that BVD received through the data channel to display in your
widget.

Single Data Field
Sparkline, line, and area charts as well as status image and text value widgets support only one data field.

For single data fields, BVD assumes that the data includes the data field value and uses the values received
for value in the widget.

Default: value

Example Line Chart:

The temperature data BVD is receiving from your New York City store already happens to include the
value data field, so you do not need to select it. Otherwise select the data field with your temperature
values.

Multiple Data Fields
Multiple area, bar, and donut charts support multiple data fields. Select a data field for each area, bar, or slice
in the chart. If you select more than four data fields, BVD automatically chooses the colors of the additional
fields. For details, see "Chart Colors" on page 87.

Donut charts only. If you select only one data field for a donut chart, a second one will be automatically
generated based on themax value. For details, see "Max Value in Donut Charts" on page 93.

Example Donut Chart:

The donut chart in the OMi sample dashboard displays the five data fields representing the number of
events per severity, resulting in a donut with five slices:
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Default Value
The value set inDefault Value is used when the data in the Status data field is empty or is not one of the
defined switch values. For example, if status: blue or if status: <empty>, then the selected default value
will be used by the Status Image widget.

You can only select one of the switch values defined in the Status Image widget.

The switch values of the BVD default Status Image widget are grey, red, green, and yellow.

Default: grey

Donut Size
TheDonut Size property configures the size of a donut chart within the 360 degrees of the circle of the donut
chart. By default, a donut completes a full circle (360 degrees). To create a gauge-like semicircle, set the
donut size to 180 degrees.

Default: 360

Donut Hole Size
TheDonut Hole Size property configures the size (in percent) of the hole in themiddle of a donut chart. To
create a pie chart, set the donut hole size to 0 percent.

Default: 35

Feed Max Items
The Feed Max Items property sets themaximum number of items to display in the Feed widget.

Hyperlink
TheHyperlink property enables you to link a widget to another dashboard or to a URL. When a user then
clicks the widget, the linked dashboard or URL opens and replaces the current dashboard in the browser.
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Image Selection Rule
The Image Selection Rule property enables you to determine the image to display depending on the
outcome of a rule.

Note: Image selection rules override the values received for the Status Field.

You can addmultiple rules separated by semicolons:

Rule format: <rule>;<rule>;...

Rules can contain a value only; for example, the value green in an image selection rule selects the switch
value green. Rules can also contain conditions that must bematched; for example,
green:statusColor==verde selects the switch value greenwhen the value of the data field statusColor is
verde.

Rules are evaluated from left to right. When one condition is matched, no additional rules will be evaluated. If
no rule matches, the default is applied; therefore, when you define a set of rules, always insert the default as
the last rule.

Image selection rules have the following format:

<switch value>[:<property><operator><value>]

<switch value>
Switch value assigned to an image in the Status Image shape. The switch values of the default Status
Image shape are green, yellow, red, and grey.

<property>
The name of the data property to use to calculate the color.

<operator>
The operation that is used to compare the current value of the property with the given value. For a list of
operators, see "Rule Operators" on page 77.

<value>
The value the operator works on.

Example:

green:statusColor==verde;yellow:statusColor==amarillo;red:statusColor==rojo;grey

If the value of the data field statusColor is verde, the image with the switch value green is selected. The
value amarillo selects the image yellow, rojo selects red, and the image grey is displayed in all other
cases.

Max Value

Max Value in Bar Charts
SetMax Value to set themaximum value the chart should display.

Default: 100
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Max Value in Donut Charts
SetMax Value to set amaximum value for the chart. Setting theMax Value property is only relevant for
donut charts with only one data field. If two or more fields are selected, Max Value is disabled.

Default: 100

Example Donut Chart:

If the current value of the data field is 30 andMax Value is set to 100, the donut chart will display two
slices: one slice with the value 30 and the other slice with the value 70.

Max Value in Line, Sparkline, Area, and Multiple Area Charts
Line, sparkline, area, andmultiple area charts have amin and amax value property. Set Min Value andMax
Value to adjust the range of data displayed in the chart. Data outside this range is cut from the chart.

If Chart Autoscale is used, themin andmax values are ignored.

Default: 100

Examples:

The following three sparklines have the same size and show the same data. The scaling, however,
differs because of different min andmax values or Autoscale:

Min Value
SetMin Value andMax Value to adjust the range of data displayed in the chart. Data outside this range is
cut from the chart. If Chart Autoscale is used, themin andmax values are ignored.

Default: 0

Examples:
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The following three sparklines have the same size and show the same data. The scaling, however,
differs because of different min andmax values or Autoscale:

Mouse Over
TheMouse Over property enables you to enable or disable themouse over tooltip. The tooltip offers detailed
information on the current data point. The indicator and the tooltip font can be customized in Visio.

Default: selected

Number Format
Use theNumber Format property to format or manipulate the values displayed below the charts.

Number format works as documented here: http://numeraljs.com/

Number format respects the current locale for formatting.

Example:

'$0,0.00'

This example changes the number 1000.234 to the string $1,000.23.

Reverse Order of Data Fields
Use theReverse Order of Data Fields property to change the display order of the donut slices (or data
fields) from clockwise to counterclockwise. This property is useful when your donut chart starts at an angle
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contrary to the natural reading direction.

For example, to create the following gauge-like semicircle donut, set the start angle to 90 and the donut size
to 180. The first slice starts at 90 degrees with the data sources organized clockwise. To change the order of
the slices to counterclockwise, click theReverse the Display Order of the Data Fields check box in the
donut widget properties.

Default: not selected

Show Chart Numbers
TheShow Chart Numbers property has the following effect:

l Bar and donut charts. Shows or hides the numbers.
You can customize the formatting of the numbers (for example, change color or font) by reformatting the
number "1" in Visio.

l Line, area, and multiple area charts. Shows or hides x- and y-axes. See also "Showing or hiding x- and
y-axes" on page 101.
You can customize the x- and y-axes by changing the font and color in Visio.

Default: selected

Tip: Use theNumber Format property to format or manipulate the values.

Start Angle
TheStart Angle property determines the location of the first slice in a donut chart. By default, the first slice
(or data field) starts at 0 (zero) degrees within the 360 degrees of the circle of the donut chart.

Default: 0 (zero)

Status Field
TheStatus Field property enables you to select a data field in the received data that contains a switch value
for the Status Image widget.

By default, BVD assumes that the data includes the data field status and uses the values received for
status to update the color.
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Note: Image selection rules override the values received for the Status Field.

Default value: status (providing switch values)

Example:

The temperature data BVD is receiving from your New York City store already happens to include the
status data field, so you do not need to select it. Otherwise select the data field that contains your
switch values.

Transparent Background
Select Transparent Background to hide the placeholder shape and show the feed as a transparent overlay.

URL
Specifies theURL of the web page you want to show in this widget.

Example:

https://softwaresupport.hp.com/group/softwaresupport/search-result?keyword=

Visibility Rule
TheVisibility Rule property enables you show or hide the widget based on the outcome of a rule.

Tip: You can also use the Status Visible Group widget to show or hide a widget. Use the group widget
when you want to show or hide non-BVD shapes, or to show or hide a large number of shapes. Then it is
easier to group the shapes with the Status Visible Group and set the visibility rule in the group widget.
See also "Status Visible Group" on page 85.

Visibility rules have the following format:

<property><operator><value>

<property>
The name of the data property to use to calculate the visibility.
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<operator>
The operation that is used to compare the current value of the property with the given value. For a list of
operators, see "Rule Operators" on page 77.

<value>
The value the operator works on.

Example:

errors>=10

If the value of the data field errors is greater than or equal to ten, the widget is shown in the dashboard.
In all other cases, the widget is hidden.

Data Aging
By default, up to 500 data records per data channel are stored in the database. The aging process scans the
database every hour to identify and automatically delete records that exceed the configuredmaximum or that
are older than 100 days. You canmodify the aging defaults as follows:

1. Edit the BVD configuration .ini file. A sample configuration .ini file is provided in the following location:

Windows: <BVD_Install_Dir>\BVD\config_example.ini
Linux: /opt/HP/BVD/config_example.ini

2. Configure the following parameters in the [Aging] section of the BVD configuration .ini file:

agingInterval

Time interval (in minutes) at which the aging process scans the database to identify and
automatically delete data records.
If the parameter is missing or commented out, the aging process runs every 60minutes by default.
The valuemust be an integer greater than 0.
Default: 60minutes

purgeMoreThan

Maximum number of data records stored in the database per data channel. If this number is
exceeded, the oldest records are deleted by the aging process.
If the parameter is missing or commented out, no records are deleted based on this criteria. The
valuemust be an integer greater than 0.
Default: 500

purgeOlderThan

Time period (in days) during which data records are kept in the database. Records older than the
configured time period are automatically deleted by the aging process.
If the parameter is missing or commented out, no records are deleted based on this criteria. The
valuemust be an integer greater than 0.
Default: 100 days

unusedChannelStorageTime

Time period (in days) during which a data channel is available in the list of data channels in the widget
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properties. If a data channel does not receive any data during the configured time period and the data
channel is not associated with a widget, it is deleted from the Redis data store. If the data channel is
associated with a widget, the channel is not deleted even if the data last received for the channel is
older than the configured time period.
If the parameter is missing or commented out, no records and channels are deleted based on this
criteria. The valuemust be an integer greater than 0.
Default: 1 day

Note: The aging process cannot identify and automatically delete data records if both
purgeMoreThan and purgeOlderThan aremissing or commented out. The database will therefore
grow with the number of records received.

3. Run the BVD configuration tool using your modified configuration .ini file as input:

Windows: "<BVD_Install_Dir>\BVD\bin\configure.bat" -c <configuration_file>.ini

Linux: /opt/HP/BVD/bin/configure.sh -c <configuration_file>.ini

4. After the configuration tool completes, verify that the BVD processes are running, type:

ovc -status

Tips and Tricks
This section includes:

l "Font usage" below
l "Exporting Visio drawings to SVG" on the next page
l "Defining data channels in Visio" on page 100
l "Showing or hiding x- and y-axes" on page 101
l "Displaying small fonts in Firefox" on page 101
l "Displaying horizontal or vertical lines with gradient line color" on page 101
l "Showing widget tooltips even if the widget is overlaid by another shape" on page 102
l "Inserting Twitter feeds in a dashboard" on page 103
l "Linking dashboards" on page 103
l "Improving loading time of dashboards with raster graphics" on page 103

Font usage
For BVD to be able to render the text as designed in Visio, youmust make the fonts used in Visio available to
the web browser where you view the dashboards. If the web browser does not have access to the fonts, the
system default fonts are used.

For example, if you use theWindows font Calibri in Visio, and then view your dashboard in a browser on a
Linux system, the browser will substitute Calibri with a Linux system font because Calibri is not installed.

To enable platform-independent text rendering, useGoogle Fonts when designing your dashboard drawings in
Visio. BVD then directs the browser to load the fonts from http://www.google.com/fonts when displaying a
BVD dashboard.
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You can also use custom fonts but youmust set up a publicly accessible web server that serves the fonts
and specify a CSS definition for your custom font in the System Settings page. See "Use Custom Fonts in
Your Dashboards" on page 39 for details.

Exporting Visio drawings to SVG
When you save a Visio drawing as an SVG file make sure that the following settings are selected:

l Save as type: Scalable Vector Graphics (*.svg)
l Select: Include Visio data in the files
l Tip: Press Ctrl+A to select everything in the drawing. This ensures that your entire drawing is exported
and not the currently selected element only.

Alternatively, click theExport Dashboard button in theDashboard ribbon, if you have installed the BVD
VisioAddin.
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Defining data channels in Visio
It is a lot more convenient to connect a widget to a data channel using theManage Dashboards page, but you
can also do this directly in Visio.

In Visio, separate your dims and tags using a lower than sign followed by a greater than sign (<>), for
example:

Tip: If the lower than and greater than signs (<>) are in a dim or tag name, youmust escape them with a
backslash (\), for example:

Dims and tags in widget: store Cash1 data<>Changed

Dims and tags in Visio: store<>Cash1<>data\<>Changed
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Showing or hiding x- and y-axes
Line, area, andmultiple area charts by default show x- and y-axes. You can hide the axes by clearing the
Show Chart Numbers check box in the widget properties.

The availability of the check box is controlled by the Visio shape dataShow Chart Numbers, which is by
default set to TRUE. If you change this to FALSE and then re-import the exported SVG file, the check box is
removed from the widget properties. To re-enable the check box, change the setting to TRUE in Visio and re-
import the drawing to BVD.

Displaying small fonts in Firefox
Firefox displays small fonts in SVGs larger than their intended size. To work around this problem, make the
original SVG file bigger and let the browser scale it down.

Displaying horizontal or vertical lines with gradient line color
SVG files do not display horizontal or vertical lines with gradient line color. The lines need to deviate from
being horizontal or vertical.
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Showing widget tooltips even if the widget is overlaid by another shape

Note: To add data to a shape, Visio must be running in developer mode: File > Options > Advanced >
Run in developer mode.

If you have placed a Visio shape on top of a BVD shape, you can configure the obscuring shape to display the
BVD tooltips by adding the shape data opr_no_mouse_action:

Set the value of opr_no_mouse_action to TRUE. This makes the obscuring shape transparent to themouse
and enables the BVD widget to display tooltips onmouse over.
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Inserting Twitter feeds in a dashboard
Although the name suggests it, Twitter feeds cannot be inserted directly in a dashboard using the Feed
widget. You would first need to convert the tweets to JSON format and then send the converted tweets to
BVD.

The steps below describe an alternativemethod to include tweets using theWeb Page widget:

1. Prerequisite. You need a web server that is configured to serve HTML files and allows the inclusion of its
pages into the BVD page (X-Frame-Option HTTP Header).

2. Place an HTML file with the following content on the web server:

<html>
   <head>
      <style>
         iframe {
                height: 100%;
                }
      </style>
</head>
<body style="margin:0">
</body>

3. Place the HTML snippet provided by Twitter between the body tags of the HTML file.
4. Add aWeb Page widget to your dashboard and set its URL property to the URL of the page located on

your web server. For details, see "Web PageWidgets" on page 85.

Linking dashboards
You can link dashboards by inserting any widget and selecting the target dashboard in theHyperlink
property. When a user clicks the widget, the linked dashboard opens and replaces the current dashboard in
the browser.

If the link should be a simple button, without status updates, use the Text Value widget as follows:

1. Insert a Text Value widget in your Visio drawing, change the default text "Value" to what will be your link,
and style the widget as desired. Export the drawing to SVG and then upload the SVG file to BVD.

2. In BVD, edit the Text Value widget:
a. Do not select aData Channel. This will cause an error, which you can ignore.
b. Use theHyperlink drop-down list to select the dashboard you want to link to.

3. Save your changes to the dashboard. Then view the dashboard and test the link.
For details, see "Text ValueWidgets" on page 85.

Improving loading time of dashboards with raster graphics
Raster graphics images in dashboards increase the size and therefore the loading time of the dashboards. To
reduce the size of the images, compress them in Visio before saving your drawing to SVG. In Visio, select
the image, then click Format > Compress Picture. Increasing the compression reduces the file size but
also the quality of the image.
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Troubleshooting
This section includes:

l "Installation log files" below
l "Configuration and runtime log files" on the next page
l "Managing BVD processes" on page 106
l "Enabling debug logs" on page 106
l "Clearing user locks " on page 106
l "Verifyingmetrics forwarding from OMi to BVD" on page 107

Installation log files
The following log file contains the logs of the overall installation process:

Windows: %TEMP%\HPEBVD_<version>_HPOvInstaller.txt

Linux: /tmp/HPEBVD_<version>_HPOvInstaller.txt

For log files of the individual packages, see the following directory:

Windows: %TEMP%\HPOvInstaller\HPEBVD_<version>

Linux: /tmp/HPOvInstaller/HPEBVD_<version>
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Configuration and runtime log files
BVD keeps log files to help you troubleshoot the application. You can view log files with any text editor. Most
log files are located in the following directory:

Windows: <BVD_Data_Dir>\BVD\log\

Linux: /var/opt/HP/BVD/log/

aging-server.log

Log file of the BVD data aging process. See also "Data Aging" on page 97.

audit.log

Log file containing audit logs for successful and failed user logins. See also "Logging Into BVD" on page 8.

configure.log

Log file of the BVD configuration process. See also "Configuration" on page 25.

pgsql.log

Log file of the BVD embedded PostgreSQL database.

receiver.log

Log file of the BVD data receiver.

redis.log

Log file of the BVD embedded Redis in-memory database.

sidecar.log

Log file of the BVD bvdsc (sidecar) process. The sidecar process is responsible for licensing in BVD.

web-server.log

Log file of the BVD web server.

Installation and Administration Guide
Knowledge Base

HPE OMi Business Value Dashboard (10.10) Page 105 of 109



Managing BVD processes
The following BVD processes must be running for BVD to operate successfully:

bvdaging BVD Aging BVD (2632) Running
bvdpg BVD Postgres DB BVD (3776) Running
bvdrc BVD Receiver BVD (2532) Running
bvdredis BVD Redis Server BVD (3516) Running
bvdsc BVD Sidecar BVD (3840) Running
bvdws BVD Web Server BVD (2576) Running
ovbbccb OV Communication Broker CORE (2600) Running
ovcd OV Control CORE (2492) Running
ovconfd OV Config and Deploy COREXT (3244) Running

The BVD processes are registered with the OV Control service, which is an HPE L-Core Component and
included in the shared content installed with BVD. Use the ovc command-line interface tomanage the BVD
processes:

l Status. To check whether the processes are running, type ovc -status.
l Stop, start, and restart. You can stop, start, and restart the processes by using the -stop, -start, and -

restart options.
l Help. Formore information on ovc, type ovc -help.

Tip: On Linux, ovc may not by default be included in the PATH variable. To add the path to the shared
content to the PATH variable, type:

export PATH=/opt/OV/bin:$PATH

Enabling debug logs
In debugmode, BVD records more detailed output in its log files. To enable debugging, complete the following
steps for each process that you want to debug. You can enable debugging for the BVD aging, receiver, and
web server processes.

1. Edit the JavaScript file for the process that you want to debug:

Windows: <BVD_Install_Dir>\BVD\dashboard\scripts\*.js
Linux: /opt/HP/BVD/dashboard/scripts/*.js

2. Remove the two slashes (//) at the beginning of the following line:
//process.env.DEBUG='bvd:*';

3. Restart the processes, for example:

ovc -restart bvdaging bvdrc bvdws

Clearing user locks
BVD locks out users after five failed login attempts. The lock clears automatically 15minutes after the last
failed attempt. To clear the lock manually, restart the BVD web server:

ovc -restart bvdws
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Verifying metrics forwarding from OMi to BVD
Metrics Forwarding from Performance Graphing in OMi 9.2x and 10.0x:

1. In OMi, open Infrastructure Settings:
Admin > Platform > Setup and Maintenance -> Infrastructure Settings
In theApplications list, select Performance Graphing.

2. Set the option Trace Level to 2.
3. Access the ovpmtrace.0.txt file available at the following location:

Windows: %ovdatadir%\shared\server\log
Linux: /var/opt/OV/shared/server/log

4. The log file contains tracemessages that indicate that PerformanceGraphing is forwarding the data to
the endpoint.
The following are samples from the log file:

com.hp.pm.core.configuration.PostDataTask:run() -> JSON data to post ...
com.hp.pm.core.configuration.PostDataTask:postDashboardData() -> Post data to
service dashboard endpoint is success

Metrics Forwarding from Performance Dashboard in OMi 10.10:

1. In OMi, open Infrastructure Settings:
Admin > Platform > Setup and Maintenance -> Infrastructure Settings
In theApplications list, select Performance Dashboard.

2. Access the bvd.log file available at the following location:
Windows: <OMi_HOME>\log\pmi
Linux: /opt/HP/BSM/log/pmi

3. The log file contains tracemessages that indicate that Performance Dashboard is forwarding the data to
the endpoint.
The following are samples (trace level set to INFO) from the log file:

com.hp.pm.core.configuration.bvd.PostDataTask:postDashboardData()
-> BVD - Post data to endpoint is success
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on Installation and Administration Guide (OMi Business Value Dashboard 10.10)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client, and
send your feedback to ovdoc-asm@hp.com.

We appreciate your feedback!

Go OMi!

mailto:ovdoc-asm@hp.com?subject=Feedback on Installation and Administration Guide (OMi Business Value Dashboard 10.10)
https://hpln.hpe.com/group/operations-manager-i-omi
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